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• Copying of the commercially available musical data is strictly prohibited except for your personal use.
• This Reference Manual is the exclusive copyrights of Yamaha Corporation.
• Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.
• Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.
• Eneloop® is a registered trademark of SANYO Electric Co., Ltd.
• The microSD and microSDHC logos are trademarks.
• The company names and product names in this manual are the trademarks or registered trademarks of 

their respective companies.

* The illustrations and LCD screens shown in this manual are for instructional purposes only and may 
appear somewhat different from those on your instrument.

About the manuals
The operation of the POCKETRAK CX is explained in this Reference Manual (this file) and also in the 
Owner’s Manual (printed version). 

Owner’s Manual (printed version): The Owner’s Manual includes information about precautions, 
setup and basic operation that will get you started as easily as possible. 

Reference Manual (this file): The Reference Manual includes part names and functions, detailed 
descriptions and procedures that will help you take full advantage of the POCKETRAK CX, 
and troubleshooting information.
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Starting Up
Part names and functions

Front, side and back panels

1 LCD screen
2 [REC/PAUSE ] button

Starts or pauses recording.
3 [STOP/ESC ] button

Stops recording or playback. Press this button during the menu setting operation to 
return to the previous screen or setting.

4 [VOL +] button
Increases the volume of playback or recording monitoring. Also, it moves the cursor 
upward during menu operation or file selection.

5 [VOL -] button
Decreases the volume of playback or recording monitoring. Also, it moves the cur-
sor downward during menu operation or file selection.

6 [ ] button
Fast reverse button. Also, use this button to return to the previous screen during the 
menu setting operation or while the list screen is displayed, move the cursor to the 
left, or set the recording level.

7 [ ] button
Fast forward button. Also, use this button to proceed to the next screen during the 
menu setting operation or while the list screen is displayed, move the cursor to the 
right, or set the recording level.

8 [MENU/ENTER] button
While the main screen is displayed, press and hold down this button for at least two 
(2) seconds to display the menu screen. During the menu setting operation or 
while the list screen is displayed, press this button once to confirm the item selec-
tion or the operation.

9 Built-in stereo microphone
The recorder features a high-performance X-Y stereo microphone.
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0 LED indicator
Lights up as a “recording or playback indicator” during recording or playback, as a 
“peak indicator” if the level of the recording input source is too high, and as a 
“charging indicator” while the battery is being charged.

☞ Changing the LED setting (page 25)

q [PLAY/SPEED ] button
Starts playback or changes the playback speed in stages.

☞ Playback (page 26)
☞ Changing the playback speed (page 29)

w MIC/LINE  socket
External stereo microphone/line level input socket. Select [MIC] for the 
[REC SELECT] menu item when you connect an external microphone. Select [LINE] 
when you connect and record from an external audio device.

☞ Using an external microphone (page 10)
☞ Recording from an external audio device (such as a CD player) (page 14)

e [POWER] button
Turns the power to the POCKETRAK CX on or off. Press the button once briefly to 
turn the power on. Press and hold down the button for at least two (2) seconds to 
turn the power off.

r [FOLDER/A-B REPEAT] button
Press this button to select a folder or to use the A-B Repeat or Clear Voice function.

t [LIST/INDEX] button
To display a list of files in the selected folder, press this button while the recorder is 
stopped.
Press this button during recording or playback to insert index marks (playback posi-
tion locators).

☞ Inserting index marks (page 40)

y [EDIT/PHRASE] button
Use this button to edit a file. Alternatively, use this button to perform Phrase play-
back (the playback point will be moved back by the specified number of seconds).

☞ Editing Files (page 37)
☞ Using the Phrase playback function (page 31)
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u [DEL] button
Deletes files, folders, or index marks. It also recalls the Recycle Bin menu while the 
Recycle Bin folder is selected.

☞ Deleting (page 42)

i microSD card slot
Insert a microSD card here.

o USB terminal
Connect this terminal to a computer using the included USB cable.

p [HOLD/CHARGE] switch
To engage the Hold function (to avoid accidental operation), slide the switch in the 
direction of the arrow.
To start recharging the eneloop battery, slide the switch in the direction of the 
arrow after you connect the recorder to a computer.

☞ Recharging the eneloop (page 71)

a Headphones socket
Connect inner-ear headphones or other types of headphones here.

s [ALC ON/OFF] switch
Set this switch to ON to automatically adjust the recording level in accordance with 
the source level to optimize the dynamics of the resulting recording.

☞ Turning the ALC (Auto Level Control) on and off (page 17)

d [MIC SENS HIGH/LOW] switch
Switches the microphone sensitivity to high or low in accordance with the record-
ing environment.

f Speaker
g Battery cover
h Threaded socket for attaching a tripod or a microphone stand adapter

Use this socket to attach a tripod or a microphone stand adapter.
☞ Attaching the recorder to a tripod or a microphone stand (page 11)
☞ Page 9 of the included Owner’s Manual
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LCD screen

Hint:
What is Linear PCM (Pulse Code Modulation) recording?
Linear PCM (LPCM) recording is a digital recording method that samples analog audio 
signals at a certain frequency and saves them as digital signals without compression.
Music CDs (CD-DA – CD digital Audio) use PCM recording (sampling rate of 44.1kHz, bit 
depth of 16-bit samples, bit rate of 1,411kbps, and frequency response from 20 to 
20kHz). 
PCM recordings are digitally-recorded unprocessed audio, and are supposed to be of the 
highest sound quality. “WAVE” format is used to import these PCM recording files into a 
computer. The WAVE file extension is “.WAV”. MP3 and WMA format files are created by 
compressing the LPCM data.

External recording mode (MIC, LINE)

Timer/Alarm

Auto Divide

Recording level 
(with ALC off)

Microphone sensitivity

High Pass Filter

File number/
Total number of files

Repeat playback

Skip playback

Playback speed

Sound EQ

microSD card

Bit rate
(for recording and playing back MP3 
files and playing back WMA files)
Frequency (for PCM recording and 
playback)

Battery setting
e: eneloop
A: Alkaline battery

Remaining battery power

Folder name

File format

Information indicators
(Remaining recording 
time, elapsed recording 
time, track name, file 
name, artist name, total 
playback time, elapsed 
playback time, operation 
status, file type, current 
time and date, etc.)

VAS (Voice Activated System)
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About the screens

Navigating the list screen
This section explains how to select a file from the list screen and play it back. 

1. Press the [LIST/INDEX] button while the main screen is displayed and the 
recorder is stopped.
The recorder displays the list screen.

2. Press the [VOL +/-] buttons to select the file you wish to play.

To select a different folder, press the [ ]/[ ] buttons, or the [FOLDER/A-B 
REPEAT] button repeatedly to scroll through the folders.

· For more information on the folders, refer to “Folder structure” on page 59.

3. Press the [PLAY/SPEED ] button.
The recorder starts to play the file.

4. Press the [STOP/ESC ] button.
The recorder stops playback.
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[Main screen]

Appears when the 
power to the unit is 
turned on.

[Menu screen] Appears when you press 
and hold down the [MENU/
ENTER] button for at least 
two (2) seconds while the 
main screen is displayed.

This screen enables you to 
change Recording mode, 
set the date and time, ini-
tialize the recorder, and 
make various other settings.

[List screen] Appears when you press the 
[LIST/INDEX] button while 
the main screen is dis-
played. 

The files stored on the 
microSD card will be dis-
played in a tree structure.

LIST

Hint:
· To go back to the main screen, press the [STOP/ESC ] button.
· Press the [STOP/ESC ] button repeatedly to select one of the indicators for 

the file in the following order (if the playback file exists).
[REC REMAIN TIME]→[DATE & TIME]→[TOTAL TIME]→[REC DATE & TIME]

Selected folder

Files in the folder

Hint:
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Setting the current date and time
After you set the date and time, the POCKETRAK CX will automatically record the recording date 
and time with each file.

1. Press the [MENU/ENTER] button for at least two (2) seconds while the main 
screen is displayed, press the [VOL +/-] buttons to select [COMMON MENU], 
then press the [MENU/ENTER] button. 

2. Press the [VOL +/-] buttons to select [DATE & TIME], then press the [MENU/
ENTER] button.

3. Press the [VOL +/-] buttons to select the year, then press the [ ] button.

4. In the same way, select the month, day, 24/12-hour indication (24H or AM/
PM), hour and minute, then press the [MENU/ENTER] button.

5. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

MENU
ENTER

at least two (2) 
seconds

VOL

MENU
ENTER

MENU
ENTER

VOL

VOL
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Recording

Before recording

Attaching the wind screen (protection against wind and sibilance)
The built-in stereo microphone is highly sensitive. Therefore, a slight breeze or breath 
— even a weak air conditioning breeze that hits the microphones directly — will be 
recorded as noise. To reduce the level of wind and other environmental noise, 
Yamaha recommends that you use the recorder with the wind screen attached to the 
microphones. Also, to further minimize the noise level, Yamaha recommends that 
you turn on the High Pass Filter via menu item [HPF] (see page 21).

Selecting a Recording mode
The POCKETRAK CX records audio in the MP3 or PCM (WAV) format. As a rule of 
thumb, select “PCM 44.1kHz” (better sound quality) for Recording mode to record a 
musical performance. Select “MP3 128kbps” (smaller data size) to record musical 
practice sessions or conference meetings (see page 16).

Turning the ALC (Auto Level Control) function on or off
Auto Level Control function automatically adjusts the recording level in response to the 
input source level to optimize the dynamics of the resulting recording (see page 17).

Setting the microphone sensitivity
You can set the microphone sensitivity level to high or low to accommodate the 
input volume. If the volume level is too high, set the [MIC SENS] (microphone sensi-
tivity) switch on the left side of the unit to [LOW]. If the volume level is too low, set 
the switch to [HIGH].

Using an external microphone
You can use an external microphone for recording, instead of using the built-in stereo 
microphone.
Select [MIC] for menu item [REC SELECT], then connect an external microphone to 
the MIC/LINE socket located on the right side of the unit.
Yamaha recommends that you use a microphone with the following specifications as 
an external microphone.

ALC OFF ALC ON

Feature

The recording will accurately 
represent the original sound and 
maintain the original sound 
dynamics.

The recording dynamics will be adjusted. 
Louder sounds will be quieter and softer 
sounds will be louder. This setting will 
reduce distortion and is better for dictation.

Application
Musical performance and nature 
recordings

Musical practice, conference meeting and 
interview recordings

Type Electret condenser microphone that features plug-in power operation

Impedance 2kΩ

Power Guaranteed operation at 1.3V

Plug Mini plug (3.5mm)
CKETRAK CX   Reference Manual 10
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Attaching the recorder to a tripod or a microphone stand
You can attach the recorder to a commercially-available camera or camcorder tripod 
using the threaded socket on the unit. You can also attach the recorder to a micro-
phone stand using the included microphone stand adapter. In this way, you can set 
up the recorder in the optimum position. This can be useful for recording musical 
performances. (Please refer to page 9 of the included Owner’s Manual.)

Recording a musical performance
Before recording, set the [ALC] switch to [OFF] and the [MIC SENS] (microphone sensitivity) 
switch to [LOW].

1. Press the [FOLDER/A-B REPEAT] button located on the side panel repeatedly 
to select a folder into which to record.

Hint:
· Pressing the [FOLDER/A-B REPEAT] button repeatedly will scroll through the folders. 

Select a folder from folders A-D.

2. Press the [REC/PAUSE ] button.
The unit enters recording [STANDBY] mode. (Recording has not yet started.)

Note:
· The level meter will move left or right in response to the sound level from the micro-

phone.
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3. Press the [ ]/[ ] buttons to adjust the MIC LEVEL (recording level).
Adjust the recording level while playing music, speaking, etc.

Note:
Setting the recording peak limiter
When the recording peak limiter is set to ON, the recorder reduces sound distortion by 
automatically adjusting excessive peaks. It is recommended that you set the limiter to ON 
when you are recording audio.
To set the recording peak limiter to ON, press and hold down the [MENU/ENTER] button 
for at least two seconds, then select [REC MENU] → [REC LIMITER] → [ON].
The peak limiter is available only when the ALC is set to OFF.

Adjusting the recording level
• Setting an appropriate recording level

Adjust the recording level so that at the loudest source 
volume the level meter will move as far to the right as pos-
sible without deflecting all the way (and the recording 
LED will not turn off). 

• If the recording level is too low:
Press the [ ] button to adjust the recording level so 
that the level meter will move moderately to the right. 

Note:
· If an appropriate recording level cannot be 

achieved even if you raise the level to “40,” slide 
the [MIC SENS] switch to [HIGH]. 

• If the recording level is too high:
The level meter frequently moves all the way to the right 
and the recording LED turns off. The  indicator 
appears on the screen.
Press the [ ] button to lower the recording level.

4. Press the [REC/PAUSE ] button again.
The LED lights up in red and recording begins.
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• Indicators displayed during recording

5. Press the [STOP/ESC ] button to stop recording.
The LED will turn off, and the REC REMAIN TIME indicator will be displayed on the 
screen.

Simple recording (musical practice, meeting, etc.) 
Before recording, set the [ALC] switch to [ON] and the [MIC SENS] (microphone sensitivity) 
switch to [HIGH].

1. Press the [FOLDER/A-B REPEAT] button located on the side panel repeatedly 
to select a folder into which to record.

Hint:
· Pressing the [FOLDER/A-B REPEAT] button repeatedly will scroll through the folders. 

Select a folder from folders A-D.
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2. Press the [REC/PAUSE ] button.
The LED lights up in red and recording begins.

Hint:
· If the recording level is too high (see page 12), set 

the [MIC SENS] (microphone sensitivity) switch to 
[LOW].

3. Press the [STOP/ESC ] button to stop recording.
The LED will turn off and the REC REMAIN TIME indicator will be displayed on the 
screen.

Recording from an external audio device (such as a CD 
player)
You can record line input sources from an external audio device (such as a CD player or MD 
player).

1. Press the [MENU/ENTER] button for at least two (2) seconds while the main 
screen is displayed, press the [VOL +/-] buttons to select [REC MENU] → 
[REC SELECT], then press the [MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select [LINE], then press the [MENU/ENTER] 
button.

Note:
· Please note that you cannot adjust the recording level on the unit if [LINE] has been 

selected.

3. Connect the recorder’s [MIC/LINE] socket to the audio output connector on 
the external device.
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Use a commercially-available audio cable (stereo mini plug, 3.5mm, with no resis-
tance).

4. Adjust the volume level of the external audio device while playing the 
recording source.

Hint:
· Try a test recording to find an appropriate recording level.

5. Press the [FOLDER/A-B REPEAT] button to select the “L” folder.

Note:
· The ALC function is automatically turned off during recording to the “L” folder.

6. Play the recording source on the external audio device and press the 
[REC/PAUSE ] button.
Recording starts.

Note:
· A recording mode of “MP3:192kbps” will be selected automatically. You cannot select 

any other mode option.
· While you are recording audio through the line input from the connected external 

device, no audio will be heard from the speaker. Use the headphones to listen to the 
audio being recorded.

7. Press the [STOP/ESC ] button to stop recording.
Stop playback on the external device.

VOL
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PLAY

STOP
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5

To the external 
input socket Audio device

or LINE OUT 
(Recording) socket

To audio output 
headphones socket

Folder L
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Recording Settings

Changing the Recording mode (Selecting a sound quality)
The POCKETRAK CX enables you to record audio in MP3 or PCM (WAV) format. In PCM mode, 
non-compressed audio data will be recorded. In MP3 mode, compressed audio data will be 
recorded. With the better sound quality, the data size will be larger and available recording time 
will be shorter. Refer to the table below to select a Recording mode that will suit your purpose.

Recording mode and application examples

Available recording time (with the included microSD card)

• If you record multiple files, the total available recording time will be shorter than 
the times estimated above.

• If you are using a 2GB or larger microSD card, the largest available recording space 
(for continuous recording in one file) is 2GB.

Recording 
format

Sampling 
frequency 
or bit rate

File 
extension

Application examples

PCM
48 kHz

.WAV
Recording a musical performance, creating 
a master recording, creating a CD, and 
recording other original sound sources

Higher sound 
quality

44.1 kHz

MP3

320 kbps

.MP3

High-quality recording of musical practice 
sessions, conference meetings, etc. com-
pressed into a smaller size file

192 kbps

128 kbps
Standard 

sound quality

64 kbps
Recordings for which extended duration is 
more important than sound quality 
(“32kbps” indicates a monaural recording.)

Longer record-
ing time

32 kbps

Recording mode Available recording time (estimated)

PCM 48 kHz About 2 hours 50 minutes

PCM 44.1 kHz About 3 hours 5 minutes

MP3 320 kbps About 13 hours 35 minutes

MP3 192 kbps About 22 hours 45 minutes

MP3 128 kbps About 34 hours 5 minutes

MP3 64 kbps About 68 hours 15 minutes

MP3 32 kbps About 136 hours 30 minutes
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Changing Recording mode

1. Press the [MENU/ENTER] button for at least two (2) seconds while the main 
screen is displayed, press the [VOL +/-] buttons to select [REC MENU] → 
[REC MODE], then press the [MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select the desired Recording mode option, 
then press the [MENU/ENTER] button.

3. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

Turning the ALC (Auto Level Control) on and off

Note:
· You can turn the ALC function on or off when recording audio to folders A – D.

• Turning the ALC function on
Slide the [ALC] switch located on the side 
panel of the unit to “ON.”
The recording level will automatically be 
adjusted in response to the input level.

• Turning the ALC function off
Slide the [ALC] switch (located on the side 
panel of the unit) to “OFF.”
You can change the recording level in incre-
ments (see page 12).

Note:
· You cannot adjust the recording level when you are recording audio from a connected 

external device (see page 14).

MENU
ENTER

VOL

ESC
STOP

ALC ON

ALC OFF 
(The recording level will be displayed.)
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Setting the recording EQ (equalizer)
Setting the recording EQ enables to record the audio of the desired tonal quality by boosting the 
lower or higher frequency ranges.

You can use the recording EQ only when recording audio to folders A – D and when the ALC 
function is turned off.

About recording EQ options
The POCKETRAK CX offers eight recording EQ presets and one USER recording EQ 
option (that enables you to customize by cutting and boosting five EQ bands individ-
ually). The recording EQ presets include RECOMMENDED, FLAT, SUPER BASS, BASS, 
MIDDLE, BASS&TREBLE, TREBLE, and SUPER TREBLE.

Features of each recording EQ preset

Note:
· You cannot change the parameters of these eight recording EQ presets. Select the USER 

recording EQ option if you wish to customize the recording EQ.

RECOMMENDED FLAT SUPER BASS BASS

This preset is recom-
mended for recording 
via the built-in micro-
phone.

No EQ is used for 
recording.

This preset signifi-
cantly boosts the 
lower frequency 
range.

This preset mildly 
boosts the lower fre-
quency range.

MIDDLE BASS&TREBLE TREBLE SUPER TREBLE

This preset boosts the 
mid frequency range.

This preset mildly 
boosts the lower and 
higher frequency 
ranges.

This preset mildly 
boosts the higher fre-
quency range.

This preset signifi-
cantly boosts the 
higher frequency 
range.
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Selecting a recording EQ option

1. Set the [ALC] switch to “OFF.”

2. Press the [FOLDER/A-B REPEAT] button repeatedly to select a folder into 
which to record.
Select a folder from folders A-D.

3. Press the [REC/PAUSE ] button.
The unit displays the [STANDBY] indicator.

4. Press and hold down the [MENU/ENTER] button for at least two (2) seconds 
while the [STANDBY] indicator is displayed. 
The unit displays the recording EQ screen.

5. Press the [ ]/[ ] buttons to select the desired recording EQ option.
You can select from eight recording EQ presets and one USER recording EQ 
(which enables you to customize the EQ settings).

Hint:
· For information on how to customize the USER recording EQ option, refer to “Customiz-

ing the recording EQ” on page 20.

6. Press the [MENU/ENTER] button. 
The selection of the recording EQ is confirmed. Adjust the recording level, then 
press the [REC/PAUSE ] button again to start recording (see page 12).

Note:
· To cancel the operation, press the [STOP/ESC ] button.
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Customizing the recording EQ
The USER recording EQ enables you to customize the level of five EQ bands.

1. Select “USER” while the recording EQ screen is dis-
played.
Refer to steps 1-5 in the “Selecting a recording EQ 
option” section on page 19.

2. Press the [VOL -] button.
The 150Hz band will be selected and displayed as a black 
bar.

3. Press the [ ]/[ ] buttons to select a frequency band that you wish to 
cut or boost.
The selected frequency band will be displayed as a black bar.

4. Press the [VOL +/-] buttons to boost or cut the level of the selected fre-
quency band.
You can boost the level by as much as +12dB or cut the level by as much as -12dB 
in 1dB steps. The larger value will raise the recording level and boost the fre-
quency band.

Note:
· To adjust the level of other frequency bands, repeat steps 3 and 4.
· To cancel the operation, press the [STOP/ESC ] button.

5. Press the [MENU/ENTER] button. 
The USER recording EQ is now customized. Adjust the recording level, then press 
the [REC/PAUSE ] button again to start recording (see page 12).

Note:
· The USER recording EQ setting is retained when you turn the power off or change the 

battery. However, the setting will be lost if you change the battery without first turning 
the power off. 
CKETRAK CX   Reference Manual 20



Recording Settings

PO
Setting the recording peak limiter
When the recording peak limiter is set to ON, the recorder reduces sound distortion by automat-
ically adjusting excessive peaks. It is recommended that you set the limiter to ON when you are 
recording audio. The peak limiter is available only when the ALC is set to OFF.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, select [REC MENU] → [REC 
LIMITER] → [ON], then press the [MENU/ENTER] button.
To cancel the recording peak limiter, select [OFF].

Setting the High Pass Filter (HPF)
You can cut the low frequency range by switching the High Pass Filter on. The filter reduces the 
level of chatting voices, wind and other noise in the recording environment and enables you to 
record clearer audio.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, select [REC MENU] → [HPF 
(High Pass Filter)] → [ON], then press the [MENU/ENTER] but-
ton.
To cancel the High Pass Filter, select [OFF].

Setting Stereo Wide recording
Recording with the STEREO WIDE option set to ON will enhance and widen the stereo image of 
the recorded sound.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, select [REC MENU] → [STE-
REO WIDE] → [ON], then press the [MENU/ENTER] button.
To cancel the stereo wide setting, select [OFF].
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VAS (Voice Activated System) recording
When the VAS recording function is turned on, if the unit is in recording pause mode, the unit 
will automatically start to record as soon as it detects audio at a level above a certain threshold. 
The unit will pause recording when the detected audio level falls below the threshold. VAS 
recording is available only when ALC is set to ON.

Note:
· Audio at a level below a certain threshold will be undetected and will not be recorded. If 

you are planning to record important audio, set the VAS recording to OFF.

1. Press the [MENU/ENTER] button for at least two (2) sec-
onds while the main screen is displayed, select [REC 
MENU] → [VAS] → [ON], then press the [MENU/ENTER] 
button.

2. Press the [STOP/ESC ] button twice.
“VAS” will appear on the main screen.

3. Press the [REC/PAUSE ] button.
As soon as the unit detects audio, recording begins.
If the unit does not detect any audio, the elapsed recording 
time indicator and the VAS indicator will flash, and the unit 
will enter Recording Pause mode.

Note:
· If the recorder does not detect any audio or does not pause recording, adjust the 

threshold by following the procedure in the “Setting the voice sensing level (VAS value)” 
section below.

· If you start recording while the VAS function is turned on, the first two seconds or so will 
be recorded with no exception.

Setting the voice sensing level (VAS value) 
You can adjust the voice sensing level in five steps (1-5) to accommodate the source 
volume level. A larger value will increase the voice activation sensitivity so recording 
will be triggered by lower-level audio. If the value is too small, the recorder may not 
detect audio. Set the microphone sensitivity (see page 10) in accordance with the 
source input level so that the VAS function can work more effectively.

Procedure:
To adjust the voice sensing level, press the [ ]/[ ] buttons 
while recording with the VAS function turned on.

Note:
· If the High Pass Filter is turned on, the filter will cut the low range, and recording may 

not start. In this case, set the VAS function to Off.

VAS indicator

VAS value
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Setting the Auto Divide function (AUTO DIVIDE)
If you turn the Auto Divide function on when recording a line source, such as tracks from a CD 
player, the unit automatically detects a silent pause between tracks and records each track as an 
individual file. More specifically, when the recorder detects a silent pause of two seconds or 
longer, it pauses recording, thus storing the audio data up to the silent pause as one file. In this 
way, the unit will record the first track as file 1, the second track as file 2, and so on.

1. Press the [MENU/ENTER] button for at least two (2) sec-
onds while the main screen is displayed, select [REC 
MENU] → [AUTO DIVIDE] → [ON], then press the 
[MENU/ENTER] button.

2. Press the [STOP/ESC ] button twice.
The unit displays the main screen, including the  (Auto 
Divide) indicator.
To cancel the Auto Divide function, select [OFF] in step 1.

Note:
· The function will not work if the recorder does not detect a silence of two seconds 

between tracks on a live CD or similar source. In this case, use the Divide File function 
(see page 37) to manually divide the files.

· If the unit detects silence for 15 seconds or more, recording stops automatically.

Auto Divide indicator
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Recording with the self timer
You can specify the time duration from the press of the [REC/PAUSE ] button until the start of 
recording. This function is useful when you need some time to prepare. For example, you may 
wish to practice your musical instrument until the actual recording starts.

1. Press the [MENU/ENTER] button for at least two (2) seconds while the main 
screen is displayed, select [REC MENU] → [SELF TIMER], then press the 
[MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select a self timer value of 5, 10 or 30 seconds, 
then press the [MENU/ENTER] button.

3. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

4. Press the [FOLDER/A-B REPEAT] button located on the side panel repeatedly 
to select a folder into which to record.

5. Press the [REC/PAUSE ] button.
The recorder displays the self timer standby screen, then starts counting down for 
the duration specified in step 2. (The LED indicator flashes.)

Note:
· If the [ALC] switch is set to OFF, the unit enters recording standby mode. Adjust the 

recording level, then press the [REC/PAUSE ] button again.

6. After the time specified in step 2 expires, recording begins.

Note:
· Once self timer recording begins, the self timer recording setting turns off automatically.

Hint:
· To cancel self timer recording, press the [STOP/ESC ] button during countdown.

MENU
ENTER

VOL
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Changing the LED setting
During recording or playback, the LED indicator lights up in red or green by default (the REC/
PLAY option). However, you can set the LED indicator so that it will not light up during recording 
or playback (the OFF option). Alternatively, you can set the indicator to function as a recording 
peak LED (the PEAK/PLAY option), in which case the LED indicator will light up in red during 
excessive peaks.

1. Press the [MENU/ENTER] button for at least two (2) seconds while the main 
screen is displayed, select [COMMON MENU] → [REC/PLAY LED], then press 
the [MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select [OFF], [REC/PLAY] or [PEAK/PLAY], then 
press the [MENU/ENTER] button.

3. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

[OFF] The LED indicator remains off during recording and playback.

[REC/PLAY]
The LED indicator lights up in red during recording and in green during 
playback. It turns off during excessive recording peaks.

[PEAK/PLAY]
The LED indicator lights up in red during excessive recording peaks. The 
LED indicator is off during normal recording. The LED indicator lights up in 
green during playback.

MENU
ENTER

VOL
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Playing back files
The POCKETRAK CX plays back MP3 and WMA format files in addition to WAV format files 
recorded on the unit. To play back a file recorded on the unit, select a folder from the VOICE (A-
D) folders or the LINE (L) folder. To play back a file transferred from a computer, select the MUSIC 
(M) folder.

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select a folder from which to play 
back a file.

Hint:
· Pressing the [FOLDER/A-B REPEAT] button repeatedly will scroll through the folders.

2. Press the [ ]/[ ] buttons to select the desired file number.

3. Press the [PLAY/SPEED ] button.
The recorder starts playing back the file.

4. Press the [VOL +/-] buttons to set the proper playback volume level.
The level can be set in 21 steps (0-20).

VOL

MENU
ENTER

SPEEDPAUSE ESC
PLAYSTOPREC F

O
L

D
E

R

File number

Total number of files

File number/
Total number of files

Total playback time

Elapsed playback time
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5. Press the [STOP/ESC ] button to stop playback.
Press the [PLAY/SPEED ] button again to resume playback.

Hint:
· You can play the files in each folder from the list screen (see page 8). 

Playing back tracks from the Playlist

Hint:
· For information on creating a Playlist, refer to page 66.

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select the M (MUSIC) folder.

2. Press the [ ]/[ ] buttons to select the desired Playlist, then press the 
[MENU/ENTER] button.

3. Press the [PLAY/SPEED ] button.
The recorder starts playing the tracks in the sequence specified in the Playlist.

To resume normal playback, press the [FOLDER/A-B REPEAT] button while the unit 
is stopped.

Note:
· The unit will not play the tracks from a Playlist if the Playlist contains an error in the 

drive name, folder name, file name, etc.

Indicators displayed during playback
• VOICE (A-D) folders and LINE (L) folder

Playlist indicator

Bit rate (MP3, WMA), frequency (PCM)

File number/Total number of files

Elapsed playback time

Status indicator

Repeat play

Skip play

File format

Total playback time

Playback speed
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• MUSIC (M) folder

Note:
· With some files, the indicated elapsed playback time may not match the actual elapsed 

time. Also, the names of certain artists or tracks stored in the unit may not be displayed.

Fast forwarding and fast reversing
■ Fast forwarding and fast reversing

Press and hold down the [Y] button during playback to fast forward the currently-
playing file. Press and hold down the [T] button during playback to fast reverse the 
currently-playing file.
Release the button at the point from which you wish to play. Playback will resume 
immediately from that point.

■ Locating the file to play back
Press the [Y] button once briefly while the unit is playing or stopped to locate the 
beginning of the next file.
Press the [T] button once briefly to locate the beginning of the previous file.

■ Locating the index
While the unit is playing back a file that contains index marks, press the [Y] button 
once briefly to skip to the next index mark.
Press the [T] button once briefly to locate the previous index mark.

Hint:
· For information on inserting index marks, refer to page 40.

Using headphones
Use headphones if you do not want sound to be output from the speaker or if the sound from 
the speaker is difficult to hear. Connect the headphones to the headphones socket located on the 
side panel of the unit.

You can listen to music and enjoy better sound quality by using the headphones and setting the 
Sound EQ function (see page 34). 

Note:
· The Sound EQ function is effective only for playback through headphones.

Playlist/folder playback indicator
: Playing back tracks from a folder located 

one hierarchy level below the M folder
: Playing back tracks from a folder located 

two hierarchy levels below the M folder
: Playing back from the Playlist

Bit rate (MP3, WMA), frequency (PCM)

File number/
Total number of files

Elapsed playback time

Status indicator

Track/file name

Repeat play

Skip play

Playback speed

Sound EQ

File format
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Playback Settings

Changing the playback speed
You can decrease or increase the playback speed, if necessary. This is useful if you want to listen 
carefully to complex musical parts or to skip quickly through unimportant parts of a recorded 
meeting.

1. During playback, press the [PLAY/SPEED ] button.
Each press of the button will cycle through three playback speeds: PLAY (normal), 
SLOW and FAST. The corresponding playback speed indicator appears on the 
screen.

The playback speed varies with the file format as follows:

The recorder remembers the changed playback speed after the playback is 
stopped, and will use that speed for the next playback operation. However, the 
playback speed will be reset to “normal” when the power is turned off.

Note:
· You can change the speed only for playback of MP3 and WMA files. You cannot change 

the speed for playback of PCM (WAV) files.
· Some files may not play correctly when the playback speed is changed.

PLAY (normal) SLOW FAST

Indicator  none  S  F 

MP3 100% 70% 150%

WMA 100% 70% 120%

Playback speed (FAST)
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Playing back specific sections of a track
You can specify and quickly locate a desired section of a track in three ways. This can be useful if 
you want to skip unimportant parts during playback or to repeat playback of a particular portion 
of the file. The POCKETRAK CX features three special playback functions: Skip playback (locating 
the playback point immediately), A-B Repeat playback (playing a specified part repeatedly), and 
Phrase playback (moving the playback point back by a specified number of seconds).

Using the Skip playback function
You can skip forward or back by a specific amount of time. This function is useful 
when you want to locate a desired playback point immediately.

1. During playback, press the [ ]/[ ] buttons.
Playback will skip ahead or back by the specified amount of time.

Note:
· The playback point will not skip to the next or previous folder. The function is effective 

only within one folder.
· If the distance between the current point and an index mark or the beginning of the 

next file is shorter than the distance between the current point and the skip point, the 
recorder will locate the index mark or the beginning of the next file.

■ Setting the amount of time for Skip playback

1. Press the [MENU/ENTER] button for at least two 
(2) seconds while the main screen is displayed, 
select [PLAY MENU] → [SKIP PLAY], then press the 
[MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select a skip time 
value of “30 sec,” “1 min,” “10 min” or “30 min,” 
then press the [MENU/ENTER] button.

3. Press the [STOP/ESC ] button twice.
The unit displays the main screen, including the 

 indicator in the lower-right corner.

Hint:
· You can set the skip time value by displaying the menu screen during playback.
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Using the A-B Repeat playback function
During playback, you can specify a part of a file that you want to play repeatedly 
(from point A to point B).

1. During playback, press the [FOLDER/A-B REPEAT] button at the desired start 
point (A) for A-B Repeat playback.
The start point indicator lights up.

2. Press the [FOLDER/A-B REPEAT] button at the desired end point (B) for A-B 
Repeat playback.
The end point is set, and the unit starts playing back the part between A and B 
repeatedly until you cancel the A-B Repeat function.

To cancel A-B Repeat playback, do one of the following operations during A-B 
Repeat playback:

• Press the [FOLDER/A-B REPEAT] button again.

• Press the [STOP/ESC ] button.

• Press the [ ]/[ ] buttons.

Note:
· If the duration between point A and B is too short, you will be unable to set up A-B 

Repeat playback.
· If you set point A, but not point B, the end of the file will automatically become point B.

Using the Phrase playback function
You can move back the playback point in the currently-playing file by a specified 
number of seconds. This function is useful if you want to listen again to a short phrase 
in a piece of music or an important piece of audio.

1. During playback, press the [EDIT/PHRASE] button.
The playback point will move back by the specified number of seconds and play-
back will resume.

Start point indicator

A-B Repeat indicator
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Note:
· During A-B Repeat playback, the Phrase playback function remains effective between 

points A and B.
· If the specified number of seconds exceeds the time between the current playback point 

and the beginning of the file, the unit will play back from the beginning of the file.
· The playback point can be moved back to the beginning of the file, but no further. It 

cannot jump into the previous file.

■ Setting the amount of time for Phrase playback.

1. Press the [MENU/ENTER] button for at least two 
(2) seconds while the main screen is displayed, 
select [PLAY MENU] → [PHRASE PLAY], then press 
the [MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select the amount of 
time to move back the playback point (5, 10 or 15 
seconds), then press the [MENU/ENTER] button.

3. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

Hint:
· You can specify the amount of time for Phrase playback by displaying the menu screen 

during playback.

Playing back the same track repeatedly
You can play back the same track repeatedly (Repeat playback). The Repeat playback function 
features various Repeat playback modes, such as playing back the same file repeatedly, playing 
files in a folder in normal or random sequence, etc.

■ Setting the Repeat playback mode

1. Press the [MENU/ENTER] button for at least two 
(2) seconds while the main screen is displayed, 
select [PLAY MENU] → [REPEAT], then press the 
[MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select a Repeat play-
back mode from [OFF], [ONE], [ALL] or [RANDOM], 
then press the [MENU/ENTER] button.

[OFF] No repeat

[ONE] Repeats only the currently-selected file.

[ALL]
Repeats all files in the current folder. (The unit 
will not perform Repeat playback across folders.)

[RANDOM]
Repeats all files in the current folder in random 
sequence. (The unit will not perform Random 
playback across folders.)
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3. Press the [STOP/ESC ] button twice.
The unit displays the main screen with the Repeat mode indicator in the lower-
right corner.

4. Press the [PLAY/SPEED ] button.
The unit will perform the selected Repeat playback.
To cancel Repeat playback, select [OFF] as the Repeat playback mode.

Hint:
· You can select a Repeat playback mode by displaying the menu screen during playback.

Playing back with less noise (Clear Voice)
The Clear Voice function makes audio playback less static or noisy and easier to listen to. You can 
use this function for the files in the VOICE (A-D) folders. This function is not effective on files in 
the LINE (L), MUSIC (M) and Recycle Bin ( ) folders.

1. During playback, press and hold down the [FOLDER/A-B REPEAT] button 
located on the side panel for at least two (2) seconds.
The Clear Voice function turns on.

Press and hold down the [FOLDER/A-B REPEAT] but-
ton again for at least two (2) seconds to turn off the 
function.

Note:
· This function is especially effective on the playback of files recorded in PCM 48/44.1kHz 

or MP3 320/192/128kbps mode.
· Depending on how the audio was originally recorded, the noise may not be reduced.

ONE

ALL

RANDOM
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Setting the sound EQ (equalizer) (applicable only to the 
M and L folders)
You can set the sound EQ to adjust the overall tone of music. The function is available only when 
you play back files in the LINE (L) or MUSIC (M) folder through the headphones.

About the sound EQ options
The POCKETRAK CX offers six sound EQ presets and one USER EQ option (which 
enables you to cut and boost five bands individually to suit your preference). The 
sound EQ presets include FLAT, BASS1, BASS2, POP, ROCK and JAZZ.

Features of each sound EQ preset

Note:
· You cannot change the parameters of the six sound EQ presets. Use the USER EQ option 

if you wish to adjust the sound EQ to suit your preference.

FLAT BASS1 BASS2

No EQ is used. The original 
sound will be played as is.

This preset mildly boosts the 
lower frequency range.

This preset significantly boosts 
the lower frequency range.

POP ROCK JAZZ

This preset significantly boosts 
the higher frequency range.

This preset mildly boosts the 
lower and higher frequency 
ranges.

This preset boosts the mid fre-
quency range.
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Selecting a sound EQ option

1. Press the [MENU/ENTER] button for at least two 
(2) seconds while the main screen is displayed, 
select [PLAY MENU] → [SOUND EQ], then press the 
[MENU/ENTER] button.

2. Press the [ ]/[ ] buttons to select the desired 
sound EQ option.
Select from six sound EQ presets and one USER EQ 
option (which enables you to customize the EQ set-
tings).

Hint:
· For information on how to customize the USER EQ option, refer to “Customizing the 

sound EQ option” on page 36.

3. Press the [MENU/ENTER] button. 
The selection of the sound EQ option is confirmed.

4. Press the [STOP/ESC ] button.
The recorder displays the main screen.

Hint:
· You can select a sound EQ option by displaying the menu screen during playback.
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Customizing the sound EQ option
The USER sound EQ option enables you to adjust the level of five EQ bands.

1. Select “USER” as the sound EQ.
Refer to steps 1 and 2 in the “Selecting a sound EQ 
option” section on page 35.

2. Press the [VOL -] button.
The 150Hz band will be selected and displayed as a 
black bar.

3. Press the [ ]/[ ] buttons to select the frequency band to cut or boost.
The selected frequency band will be displayed as a black bar.

4. Press the [VOL +/-] buttons to boost or cut the level of the selected fre-
quency band.
You can boost the level by as much as +12dB or cut the level by as much as -12dB 
in 1dB steps. The larger value will raise the playback level and boost the frequency 
band.

Note:
· To adjust the level of other frequency bands, repeat steps 3 and 4.
· To cancel the operation, press the [STOP/ESC ] button.

5. Press the [MENU/ENTER] button. 
The USER sound EQ option is now customized.

6. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.
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Dividing files
You can divide any file recorded and stored in the VOICE (A-D) folders or LINE (L) folder into two 
pieces. This feature enables you to remove an unwanted part of a recording while retaining the 
part you wish to keep.

IMPORTANT
Once a file is divided in two, the pieces cannot be rejoined. Be sure to backup important files on a 
computer or other device before you divide any file.

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select a folder that contains the file 
you want to divide.

2. Press the [ ]/[ ] buttons to select the desired file number, then press 
the [PLAY/SPEED ] button.
The recorder starts playing back the file.

3. Press the [STOP/ESC ] button at the point at which you wish to divide the 
file.
The recorder stops playback.

4. Press the [EDIT/PHRASE] button located on the 
side panel, press the [VOL +/-] buttons to select 
[DIVIDE], then press the [MENU/ENTER] button.

5. Press the [ ]/[ ] buttons to select [YES], then 
press the [MENU/ENTER] button.
The recorder displays the message “DIVIDING…,” 
then “DIVIDE COMPLETED!” and the file division 
operation is complete.
When a file is divided, the number of files in the folder 
increases by one.

Note:
· You can divide only MP3 or WAV files recorded on the unit.
· If the file length is too short, the unit displays the message “CANNOT DIVIDE AT THIS 

POINT!” and the file will not be divided. This function is not effective on files in the 
MUSIC (M) and Recycle Bin folders.

· If you divide a file that contains index marks (see page 40), the index marks will be 
deleted.
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■ File names after division

For example, if you divide a file named “IC_A_001.MP3”, a new file named 
“IC_A_002.MP3” will be created. If the new file has the same name as a file that 
already exists in the folder, the new file will keep the name, and the existing file will 
be renamed automatically.

■ Overlap time and minimum file length required for division
The two pieces created by a file division overlap each other at the division point as 
shown in the table below. To be divided successfully, a file must be twice the overlap 
time or longer in duration.

Recording mode Overlap time Required length

MP3

32 kbps About 8 seconds About 16 seconds or longer

64 kbps About 4 seconds About 8 seconds or longer

128 kbps About 2 seconds About 4 seconds or longer

192 kbps

About 1 second or shorter About 2 seconds or longer
320 kbps

PCM
44.1 kbps

48 kbps

Before division

After division

Dividing a file The file name is 
automatically 
changed.
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Using the fade in and fade out effects
The POCKETRAK CX enables you to apply fade in and fade out effects to the files recorded in 
PCM (WAV) format. The fade in effect raises gradually the volume level of the first four seconds of 
the file. The fade out effect reduces gradually the volume level of the last four seconds of the file.

IMPORTANT
Once you apply the fade in/fade out effects, you cannot remove the effect. Be sure to backup 
important files on a computer or other external device before applying effects.

Applying the fade in effect

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select a folder that contains the file 
to which you want to apply the fade in effect.

2. Press the [ ]/[ ] buttons to select the desired file number, then press 
the [EDIT/PHRASE] button located on the side panel.

3. Press the [VOL +/-] buttons to select [FADE IN], 
then press the [MENU/ENTER] button.

4. Press the [VOL +/-] buttons to select [YES], then 
press the [MENU/ENTER] button.
The unit displays the message “FADE IN EXECUT-
ING…”.

Note:
· If you have selected any file other than a PCM file recorded on the unit, or if you have 

selected a file of four seconds or less, the unit will display the message “CANNOT FADE 
IN!”.

5. When the unit displays “COMPLETED”, press the 
[VOL +/-] buttons to select [AUDITION], then press 
the [MENU/ENTER] button.
The unit will play back the file with the fade in effect.

[AUDITION]
You can audition up to about 10 seconds at 
the beginning of the file with the fade in effect.

[SAVE] 
(Overwrite)

The file with the fade in effect will be saved. 
You cannot revert the file to its original status. 
(That is, you cannot undo the fade in effect.)

[CANCEL] The fade in effect will not be applied.
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6. If you are satisfied with the file after auditioning and wish to save it, press 
the [VOL +/-] buttons to select [SAVE], then press the [MENU/ENTER] button.
The file with the fade in effect will overwrite the original file.
If you do not wish to overwrite the original file, select [CANCEL], then press the 
[MENU/ENTER] button.

Note:
· If the microSD card does not have sufficient free space, you will be unable to apply the 

fade in and out effects to the file.

Applying the fade out effect
The basic procedure is the same as that for the fade in 
effect. Please refer to the “Applying the fade in effect” 
section on page 39. Please note that you must select 
[FADE OUT] instead of [FADE IN] in step 3 to apply the 
fade out effect.

Inserting and deleting index marks
Inserting index marks in a file enables you to locate the playback point immediately during the 
fast forward, fast reverse, or playback operation. You can insert index marks only in the files in the 
VOICE (A-D) folders.

Inserting index marks

1. During recording or playback, press the [LIST/INDEX] button (located on the 
side panel) at the point where you want to insert an index mark.
The unit displays the message “INDEX SETTING…” and the index mark is 
inserted.

Note:
· Recording or playback continues after you insert an index mark. Repeat the same steps 

to continue inserting more index marks in the file, if necessary.
· You can insert up to 36 index marks in each file. If you try to insert more than 36 index 

marks, the unit displays “INDEX FULL!” and no more index marks will be recorded.
· If you divide a file that contains index marks, the index marks will be deleted.

Deleting index marks

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select a folder that contains a file 
from which you want to delete index marks.

2. Press the [DEL] button located on the side panel.

3. Press the [VOL +/-] buttons to select [INDEX], then 
press the [MENU/ENTER] button.
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4. Press the [ ]/[ ] buttons to select the file 
from which you want to delete index marks, then 
press the [MENU/ENTER] button.
The selected file number flashes.

5. Press the [VOL +/-] buttons to select [YES], then 
press the [MENU/ENTER] button.
The unit displays the message “DELETING…” and the 
index marks are deleted.

Note:
· Deleting index marks will not delete the audio recording.
· You cannot delete index marks individually. All index marks in a file will be deleted.
· If you delete a file that contains index marks, the index marks will be deleted even if the 

Recycle Bin function (see page 42) is turned on. If you move the file from the Recycle Bin 
back to the original folder, no index marks will be left in the file.
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Deleting

Managing the Recycle Bin
If you delete a file on the recorder while the Recycle Bin function is active, the file will be moved 
to the Recycle Bin ( ) folder temporarily so that you can restore it later if necessary. If you 
delete a file or folder on the recorder while the Recycle Bin function is turned off, the file will be 
deleted completely and you will be unable to restore it. It is recommended that you turn the 
Recycle Bin function on to avoid accidental erasure.

Note:
· The Recycle Bin folder can accommodate up to 500 files. If the Recycle Bin folder is full 

and you cannot move any more files to the Recycle Bin, move some files from the Recy-
cle Bin folder to the original folder (see page 43) or empty the Recycle Bin folder (see 
page 44).

Activating the Recycle Bin function

1. Press the [MENU/ENTER] button for at least two (2) 
seconds while the main screen is displayed, press 
the [VOL +/-] buttons to select [COMMON MENU] 
→ [RECYCLE BIN] → [ON], then press the [MENU/
ENTER] button.
The Recycle Bin function is turned on.

2. Press the [STOP/ESC ] button twice to go back to 
the main screen.

Note:
· You can move files to the Recycle Bin folder only from the VOICE (A-D) folders and LINE 

(L) folder. You cannot move files from the MUSIC (M) folder to the Recycle Bin folder, 
regardless of whether the Recycle Bin function is on or off. These files will be deleted 
completely by the delete operation.

· If you initialize a microSD card, all files on the card will be deleted (and will not be 
moved to the Recycle Bin folder). All files previously moved from the card to the Recycle 
Bin folder will also be deleted.

· If you move files to the Recycle Bin folder, the index marks in those files will be deleted 
automatically.

· If the Recycle Bin function is active, deleting the files will not increase the available 
recording time.

Displaying the Recycle Bin folder
While the main screen is displayed, press the [FOLDER/A-B REPEAT] button located on 
the side panel repeatedly to select the Recycle Bin ( ) folder.
• The Recycle Bin folder contains no files.
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• The Recycle Bin folder contains files.

The files moved into the Recycle Bin will be renamed automatically (see page 59).

Playing back a file in the Recycle Bin folder

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select the Recycle Bin ( ) folder.

2. Press the [ ]/[ ] buttons to select the desired 
file to play, then press the [PLAY/SPEED ] button.
The selected file will play.

Restoring a file from the Recycle Bin folder

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select the Recycle Bin ( ) folder.

2. Press the [DEL] button located on the side panel.

3. Press the [VOL +/-] buttons to select [RESTORE], 
then press the [MENU/ENTER] button.

4. When the Restore screen is displayed, press the 
[ ]/[ ] buttons to select the desired file, then 
press the [MENU/ENTER] button.
The selected file number flashes.

5. Press the [VOL +/-] buttons to select [YES], then 
press the [MENU/ENTER] button.
The recorder will display the message “RESTOR-
ING…”, then “RESTORED TO THE BOTTOM OF " (if 
the file previously belonged to folder A), and the file 
will move back to its original folder.

File number/Total number of files in the Recycle Bin folder

Original folder that contained the file prior to deletion

File number prior to deletion
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Note:
· A file restored from the Recycle Bin will be renamed automatically and added to the end 

of the file list in the original folder (see page 38).
· If the recorder displays the message “FOLDER FULL!,” the original folder contains the 

maximum number of files allowed. In this case, delete some files to clear some space.

6. Press the [MENU/ENTER] button again. 
The recorder displays the main screen.

Emptying the Recycle Bin folder

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select the Recycle Bin ( ) folder.

2. Press the [DEL] button located on the side panel.

3. Press the [VOL +/-] buttons to select [EMPTY], then 
press the [MENU/ENTER] button.

Emptying the Recycle Bin will permanently delete all files in the Recycle Bin and the same 
files from the microSD card. You will be unable to restore those files. Be sure to backup 
important files on a computer or other external device before emptying the Recycle Bin.

4. Press the [VOL +/-] buttons to select [YES], then 
press the [MENU/ENTER] button.

The recorder displays the message “EMPTYING…”, 
then “NO DATA!”, and the Recycle Bin is emptied.

Note:
· If the Recycle Bin folder contains many files, the recorder’s operation may slow down. 

Empty the Recycle Bin regularly.

IMPORTANT
CKETRAK CX   Reference Manual 44



Deleting

PO
Deleting a selected file
You can delete a single file from a folder.

• If you delete a file while the Recycle Bin function is turned off (see page 42), you will be 
unable to restore it. Be sure to check the content of a file before you delete it.

• Before you proceed, make sure that the battery power is sufficient.

1. While the main screen is displayed, press the [FOLDER/A-B REPEAT] button 
located on the side panel repeatedly to select a folder from which to delete a 
file.

2. Press the [DEL] button located on the side panel.

3. Press the [VOL +/-] buttons to select [FILE], then 
press the [MENU/ENTER] button.

4. When the File Delete screen is displayed, press the 
[ ]/[ ] buttons to select a file to delete, then 
press the [MENU/ENTER] button.
The selected file number flashes.

5. Press the [VOL +/-] buttons to select [YES], then 
press the [MENU/ENTER] button.
The unit displays the message “DELETING…” and the 
file is deleted.

Note:
· If you decide not to execute the delete operation, select 

[CANCEL], then press the [MENU/ENTER] button. 
· You cannot cancel the delete operation if the recorder has already started the opera-

tion.

If the Recycle Bin function is active, the file will move 
to the Recycle Bin. When the recorder displays 
“MOVED TO RECYCLE BIN,” select [OK], then press 
the [MENU/ENTER] button.

Note:
· If the recorder displays the message “RECYCLE BIN FULL!,” 

the Recycle Bin folder is full. Empty the Recycle Bin, then delete the file.

IMPORTANT
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Deleting all files from a folder
You can delete all files from a selected folder.

• If you delete all files from the selected folder while the Recycle Bin function is 
turned off (see page 42), you will be unable to restore them. Be sure to check the 
contents of a folder before you delete the files.

• Before you proceed, make sure that the battery power is sufficient.

The procedure is similar to that for deleting a file. Please refer to the “Deleting a selected file” 
section on page 45. Please note that you must select [FOLDER] instead of [FILE] in step 3 to 
delete all files from the folder.

Note:
· You cannot delete any sub-folders in the MUSIC (M) folder (see pages 58 and 59) by 

using this function. To delete these sub-folders, connect the recorder to a computer and 
delete the sub-folders by using the computer.

Formatting a microSD card (Deleting all data)
Formatting a microSD card will delete all files on the card, regardless of whether the Recycle Bin 
function is turned on or off.

You must also format a commercially available microSD card before you use the card for the first 
time. 

• If you delete files from the microSD card, you will be unable to restore those files. 
Be sure to check the file contents before you delete a file.

• Be sure to backup important files on a computer or other external device.
• Before you proceed, make sure that the battery power is sufficient.

1. Press the [MENU/ENTER] button for at least two 
(2) seconds while the main screen is displayed, 
press the [VOL +/-] buttons to select [COMMON 
MENU] → [FORMAT], then press the [MENU/
ENTER] button. 

2. Press the [VOL +/-] buttons to select [YES], then 
press the [MENU/ENTER] button.
The unit displays the message “FORMATTING…”, 
then “FORMAT COMPLETED!”, and all data is deleted 
from the microSD card.

Note:
· If you decide not to execute the operation, select [CANCEL], then press the [MENU/

ENTER] button. 
· You cannot cancel the formatting operation if the recorder has already started the oper-

ation.

3. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

IMPORTANT

IMPORTANT
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Using the Timer Functions

Programming Timer recording
Timer recording enables you to set the recorder so that it will start recording at the specified 
time. Before you proceed, make sure that the current date and time on the unit have been set 
correctly (see page 9).

1. Press the [MENU/ENTER] button for at least two (2) 
seconds while the main screen is displayed, press 
the [VOL +/-] buttons to select [COMMON MENU] 
→ [TIMER & ALARM], then press the [MENU/ENTER] 
button.

2. Press the [VOL +/-] buttons to select [TIMER REC], 
then press the [MENU/ENTER] button.
The recorder displays the timer indicator.

3. Specify the recording start time ([START TIME]).
Press the [ ]/[ ] buttons to select the hour or 
minute, use the [VOL +/-] buttons to set the value, then 
press the [MENU/ENTER] button.

Note:
· You can program the time up to 24 hours ahead.

4. Specify the recording time duration ([REC TIME]).
Press the [ ]/[ ] buttons to select the desired 
recording time duration from “30m,” “1h,” “2h” or 
“MAX” (recording continues until the available space 
used up). Then press the [MENU/ENTER] button.

5. When the unit displays [SELECT FOLDER], press the 
[ ]/[ ] buttons to select the desired folder into 
which to record, then press the [MENU/ENTER] but-
ton.
Timer recording is now programmed. At the programmed 
time, the recorder automatically starts to record, and a 
new file is created in the specified folder. (The timer indica-
tor ( ) will flash during Timer recording.

Note:
· You cannot select the LINE (L), MUSIC (M) or Recycle Bin ( ) folders for Timer recording.

Timer indicator

Recording time
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6. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

Note:
· The crossed-out timer indicator ( ) means that Timer recording is unavailable due to 

one of the following reasons:
- There is no available recording time.
- The specified folder contains 199 files.
- The unit is currently playing back.
- The unit is currently recording.
- You are currently setting menu items.

· To remove the timer indicator ( ), cancel the programmed Timer recording.
· Timer recording will be cancelled once the programmed Timer recording has been exe-

cuted.
· You cannot program Timer recording if the alarm has already been programmed, and 

vice versa.

■ Canceling Timer recording
Select [CANCEL] as in step 2 of the “Programming Timer 
recording” procedure, then press the [MENU/ENTER] 
button.

Programming the alarm
If you program the alarm, it will sound at the specified time. You can specify your favorite song as 
the alarm sound instead of a beep. Before you proceed, make sure that the date and time on the 
unit have been set correctly (see page 9).

1. Press the [MENU/ENTER] button for at least two 
(2) seconds while the main screen is displayed, 
press the [VOL +/-] buttons to select [COMMON 
MENU] → [TIMER & ALARM], then press the 
[MENU/ENTER] button.

2. Press the [VOL +/-] buttons to select [ALARM], 
then press the [MENU/ENTER] button.
The recorder displays the alarm indicator.

Alarm indicator
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3. Specify the alarm time ([ALARM TIME]).
Press the [ ]/[ ] buttons to select the hour or 
minute, use the [VOL +/-] buttons to set the value, 
then press the [MENU/ENTER] button.

4. Press the [VOL +/-] buttons to select [BEEP] or 
[MUSIC] as the alarm sound, then press the 
[MENU/ENTER] button.

Note:
· If you wish to use your favorite song as the alarm instead of a beep, first connect the 

recorder to a computer, then place your favorite MP3 or WMA music file in the ALARM 
folder (see page 58). Then select [MUSIC]. If there is no file in the ALARM folder, a beep 
will sound instead of music. Make sure that the recorder’s volume level is set appropri-
ately. If the volume level is set to “0,” you will not hear the alarm at the programmed 
time.

5. Press the [STOP/ESC ] button twice.
The alarm is now programmed.
At the programmed time, the alarm will go off. If you selected “BEEP,” a beep will 
sound for about 10 seconds. If you selected “MUSIC,” the music file (the entire 
song) in the ALARM folder will be played back.

Note:
· The alarm indicator ( ) will flash while the alarm is sounding.
· Press the [STOP/ESC ] button to stop the alarm.
· You can program the time up to 24 hours ahead.
· The alarm will be cancelled once the programmed alarm has sounded.
· You cannot program Timer recording if the alarm has already been programmed, and 

vice versa.

■ Canceling the alarm
Select [CANCEL] in step 2 of the “Programming the 
alarm” procedure, then press the [MENU/ENTER] button.
The alarm indicator ( ) disappears.

[BEEP] Beep sound

[MUSIC] A music file in the ALARM folder will be played.
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About the Menu Settings

Menu and menu item list
Menu items are categorized into three main menus: [REC MENU] (Recording settings), [PLAY 
MENU] (Playback settings) and [COMMON MENU] (Global settings).

■ [REC MENU] (Recording settings)

■ [PLAY MENU] (Playback settings)

■ [COMMON MENU] (Global settings)

Menu items Description
Reference 

page

[REC MODE] Sets the recording quality. 16

[REC LIMITER] Turns the Recording peak limiter on or off. 21

[HPF] Turns the High Pass (Low Cut) filter on or off. 21

[STEREO WIDE] Turns the Stereo wide recording on or off. 21

[REC SELECT] Selects a source connected to the external input jack. 14

[AUTO DIVIDE] Divides the file automatically after a certain period of silence dur-
ing recording.

23

[SELF TIMER] Sets the time for the Self Timer recording. 24

[VAS] Turns the VAS (Voice activated system) on or off. 22

Menu items Description
Reference 

page

[REPEAT] Sets the Repeat playback mode. 32

[PHRASE PLAY] Sets the Phrase playback time (by the number of seconds the 
playback point will be moved back).

31

[SKIP PLAY] Sets the Skip playback time (by the amount of time the playback 
point will skip).

30

[SOUND EQ] Adjusts the tone. 34

Menu items Description
Reference 

page

[BEEP SOUND] Turns the beep sound on or off. 52

[REC/PLAY LED] Turns the recording/playback indicator on or off, and also sets 
the recording peak LED.

25

[DATE & TIME] Sets the calendar (date and time). 9

[TIMER & ALARM] Sets up Timer recording and alarm. 47

[BATTERY SET] Selects the eneloop or alkaline battery. 51

[AUTO OFF] Turns the Auto Power Off function on or off. 52

[BACKLIGHT] Turns the LCD backlight on or off. 52

[CONTRAST] Adjusts the LCD contrast. 53

[RECYCLE BIN] Turns the Recycle Bin function on or off. 42

[FORMAT] Formats a microSD card (deletes all data) 46

[MENU RESET] Initializes the menu settings. 53

[VERSION] Indicates the firmware version information. 53
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Setting the menu options
The following section explains how to set the menu items. The example here explains 
how to select “MP3 128kbps” for the Recording mode.

1. Press and hold down the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed. 

2. Press the [VOL +/-] buttons to select [REC MENU], then press the [MENU/
ENTER] button.

3. Press the [VOL +/-] buttons to select [REC MODE], then 
press the [MENU/ENTER] button.

4. Press the [VOL +/-] buttons to select [MP3 128kbps], 
then press the [MENU/ENTER] button.

5. Press the [STOP/ESC ] button twice.
The recorder displays the main screen.

Selecting the battery type
Select “eneloop” or “alkaline” depending on the battery type you plan to use.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, press the [VOL +/-] buttons 
to select [COMMON MENU] → [BATTERY SET], select [eneloop] 
or [ALKALINE], then press the [MENU/ENTER] button.

[eneloop] Eneloop battery (included)

[ALKALINE] Alkaline battery

MENU
ENTER

VOL
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Turning the beep sound on or off
You can set the recorder so that it will make a beep sound when you operate the buttons or if 
you make an operational error.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, press the [VOL +/-] buttons 
to select [COMMON MENU] → [BEEP SOUND] → [ON], then 
press the [MENU/ENTER] button.
To cancel the beep sound, select [OFF].

Activating the Auto Power Off function
If this function is turned on and you leave the recorder turned on for about 15 minutes without 
using it, the recorder will automatically turn off (except during recording, VAS recording standby 
mode, or playback).

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, press the [VOL +/-] buttons 
to select [COMMON MENU] → [AUTO OFF] → [ON], then 
press the [MENU/ENTER] button.
To cancel the Auto Power Off function, select [OFF].

Setting the Backlight function
When the Backlight function is turned on, the LCD backlight lights up for about 10 seconds each 
time you press a button or switch on the unit.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, press the [VOL +/-] buttons 
to select [COMMON MENU] → [BACKLIGHT] → [ON], then 
press the [MENU/ENTER] button.
To cancel the Backlight function, select [OFF]. (The backlight 
will not light up.)

Note:
· If the battery power is insufficient, the backlight will not light up.
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Adjusting the LCD contrast
You can adjust the LCD contrast on a scale of ten (10).

1. Press the [MENU/ENTER] button for at least two (2) sec-
onds while the main screen is displayed, press the [VOL 
+/-] buttons to select [COMMON MENU] → [CON-
TRAST], then press the [MENU/ENTER] button.

2. Press the [ ]/[ ] buttons to adjust the contrast, 
then press the [MENU/ENTER] button.
L (low): 1 – H (high): 10

Initializing the menu settings
Initializing the recorder settings will restore all menu settings (excluding the date and time set-
ting) to the factory default.

Note:
· Initializing the recorder settings will not delete any data on the microSD card. For infor-

mation on initializing a microSD card, refer to page 46.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, press the [VOL +/-] buttons 
to select [COMMON MENU] → [MENU RESET] → [YES], then 
press the [MENU/ENTER] button.
If you decide not to initialize the settings, select [CANCEL].

Checking the firmware version
You can check the version number of the recorder’s firmware by following the procedure below.

Procedure:
Press the [MENU/ENTER] button for at least two (2) seconds 
while the main screen is displayed, press the [VOL +/-] buttons 
to select [COMMON MENU] → [VERSION], then press the 
[MENU/ENTER] button.
The firmware version will be displayed.
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Using the POCKETRAK CX with a 
Computer
You can transfer audio files stored on the microSD card to a computer by connecting the 
recorder to the computer via an included USB cable. Transferred files are compatible for playback 
with Windows Media Player and iTunes, and can be edited using the included “Cubase AI” DAW 
software. You can also transfer audio files from a computer to the recorder for playback.

Computer system requirements
■ Windows

Computer: Windows-based computer with built-in USB interface
OS: Windows Vista, XP Professional/Home Edition

■ Macintosh
Computer: Macintosh computer with built-in USB interface
OS: Mac OS X 10.4, 10.5

Note:
· The menu items and buttons displayed on your computer may not exactly match those 

shown in this manual, depending on the OS version of your computer. This manual 
uses Windows XP and Widows Media Player 11 as examples.
Please visit the website below for the latest information on included software and sys-
tem requirements.
http://www.yamahasynth.com/

Connecting the recorder to your computer
1. Start the computer.

2. Make sure that the recorder is turned off, and then connect the included USB 
cable.

IMPORTANT
Use only the USB cable included with the recorder. The use of an improper cable may damage the 
terminal and result in a malfunction.

Insert in the 
correct 

orientation.

To the USB 
terminal

To the USB terminal
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Once the recorder is recognized by the computer, the following display appears 
on the screen.

Disconnecting the recorder from your computer
■ Windows:

1. Click  on the taskbar at the 
bottom right of the Windows 
screen, then click [Safely remove 
USB Mass Storage Device].

2. After the computer displays the 
message shown on the right, 
remove the USB cable.

■ Macintosh:

1. Drag and drop the drive icon (“NO NAME”) of the recorder on the desktop 
to the Trash Can.

2. After the drive icon (“NO NAME”) disappears from the desktop, remove the 
USB cable.

Precautions when using the USB terminal
Be sure to observe the following points when connecting the recorder to a computer's USB 
interface.
If you do not observe these points, you risk freezing the computer, corrupting the data, and 
losing the data. If the computer or the recorder freezes, restart the operating system or appli-
cation software such as Windows Media Player.

• Never disconnect the USB cable while data is being transferred.
• Be sure to wake the computer from sleep/suspended/standby mode before making a connec-

tion to the computer's USB terminal.
• Quit all applications running on the computer before connecting or disconnecting the USB 

cable.

Connected to PC
Transmitting to/

from PC

IMPORTANT
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Troubleshooting (Windows Vista/XP)
If the recorder is not recognized by the computer, refer to the information below:

■ Windows Vista
While the recorder remains connected to the computer, follow the steps below:

1. From the [Start] menu, right-click [Computer] to display the pop-up menu, 
then select [Properties] to open the “System” window.

2. Click [Device Manager] to open the user account control window. In this win-
dow, click [Continue] to open the “Device Manager” window.

3. Expand “Disk drives” and “Universal Serial Bus controllers.” “Disk drives” 
must include “Yamaha Pocketrak USB Device” and “Universal Serial Bus con-
trollers” must include the device name for the USB Mass Storage Device.

■ Windows XP
While the recorder remains connected to the computer, follow the steps below:

1. From the [Start] menu or on the desktop, right-click [My Computer] to dis-
play the pop-up menu, then select [Properties] to open the “System Prop-
erty” window.

2. Click the [Hardware] tab, then click [Device Manager] to open the “Device 
Manager” window. 

3. Expand “Disk drives” and “Universal Serial Bus controllers.” “Disk drives” 
must include “Yamaha Pocketrak USB Device” and the “Universal Serial Bus 
controllers” must include the device name for the USB Mass Storage Device.

If the “Device Manager” window does not display the correct items:

Follow the steps below.

1. Exit (quit) all running applications.

2. Disconnect all external USB devices (excluding a properly working mouse and key-
board), then connect only the recorder.

3. If the computer features multiple USB terminals, use a different USB terminal to con-
nect the recorder.

4. If the recorder is connected via a bus-powered USB hub, remove the hub, then use 
the included USB cable to connect the recorder directly to the computer's USB termi-
nal.
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About files and folders
From a connected computer, you can manage the recorder’s files that are stored in folders.

You can also transfer audio files from the recorder to a computer to save them, or from a com-
puter to the recorder for playback.

1. Connect the recorder to a computer.
Make sure that a microSD card is inserted in the unit.

2. Click to open [My Computer] from the [Start] menu.

3. Double-click [Removable Disk].
The system displays the recorder’s folders.

Note:
· If the system displays the “What do you want 

Windows to do?” panel, click to select [Open 
folder to view files], then click [OK]. The sys-
tem will display the recorder’s folders.

■ Files are stored in the following folders on the microSD card.
• VOICE (A-D)

These folders store audio files (in MP3 or WAV format) recorded by the unit. The 
VOICE folder contains sub-folders A-D.

Note:
· Do not move the files to a different folder. For example, do not move a file in the A 

folder to the B folder. Otherwise, you will be unable to play the file.
· Also, please note that if you change the name of an MP3 or WAV file (originally recorded 

on the unit) on the computer, then move the file back to the VOICE (A-D) folder, you will 
be unable to play the file on the unit. To play the file, first rename the file following the 
file naming rules, or move the file to the MUSIC (M) folder (see page 59).

1 Select

2 Click
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• MUSIC
This folder stores music and other audio files transferred from a connected com-
puter.
To play back the transferred files, the files must be in MP3 or WMA format or WAV 
files that were recorded on the unit. There are no naming rules that apply to these 
files.

Note:
· The playback sequence may change if you add files to the MUSIC folder.
· You can create sub-folders (up to two hierarchies) inside the MUSIC folder to organize 

the music files by albums or musicians (see page 59).
· Please note that if the MUSIC (M) folder contains a file with the same name as that of 

the audio file you are transferring from the computer, the file in the MUSIC folder will be 
overwritten by the one transferred from the computer.

• DATA
This folder stores data files (of MS Excel, MS Word, etc.), and enables you to use 
the recorder as a USB flash drive.

Note:
· The recorder will not play back any audio or music files that are placed in this folder.
· This folder will be recognized only by a connected computer. The recorder will not dis-

play this folder on its screen.

• LINE
This folder stores files recorded from external devices via the line connection.
Please note that if you change the name of an MP3 file (originally recorded on the 
unit) on the computer, then move the file back to the LINE (L) folder, you will be 
unable to play the file on the unit. To play the file, first rename the file following 
the file naming rules, or move the file to the MUSIC (M) folder (see page 59).

• RECYCLE
This is the Recycle Bin folder. While the Recycle Bin function is active, files deleted 
on the recorder will move to this folder. You can restore files from the Recycle Bin 
folder, which can be a life saver if you delete a file accidentally.

• ALARM
This folder stores MP3 or WMA files, or WAV files recorded on the unit. Any of these 
files can be played as an alarm. Only one file at a time can be played as an alarm.

Note:
· If this folder contains no files, the beep sound will be used as the alarm, regardless of 

the Alarm timer setting.
· This folder will be recognized only by the connected computer. The recorder will not dis-

play this folder on its screen.
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■ Folder structure of the POCKETRAK CX

About the file naming rules
The POCKETRAK CX automatically names the recorded files, following the file naming rules as 
shown below:

1 Folder name (Variable with a folder that contains the file.)

2 File number (Each recording will be numbered sequentially, e.g., 001, 002, 003, etc.)

3 Extension (File format. MP3 for an MP3 recording file, and WAV for a PCM recording 
file.)

Files moved into the Recycle Bin will be renamed as follows:

1 File number in the Recycle Bin (Each file will be numbered sequentially based on when 
the file was moved to the Recycle Bin (e.g., 001, 002, 003, etc.)

2 Folder name (The folder that originally contained the file before it was moved to the 
Recycle Bin.)

3 File number (The original number of the file before it was moved to the Recycle Bin.)

4 Extension (File format. MP3 for an MP3 recording file, and WAV for a PCM recording 
file.)

Folder
File

VOICE (A-D) folders: Store audio 
files recorded on the unit.
Each folder accommodates up to 
199 files.

LINE (L) folder: Stores files recorded 
via the line input.
Accommodates up to 199 files.

MUSIC (M) folder: Stores music files for 
playback.
Each sub-folder accommodates up to 999
files.

Recycle Bin ( ) folder: 
Accommodates up to 500 files.

IC_A_001.MP3
1 2 3

001_IC_A_001.MP3
2 3 41
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Transferring audio files from the recorder to a computer 
■ Windows:

1. Connect the recorder to a computer.

2. Open [My Computer] from the [Start] menu.

3. Double-click [Removable Disk].

4. Double-click the “VOICE” folder.

5. Double-click the folder (A-D) that contains the file that you wish to load to 
your computer.

6. Copy the file to the desired location.

■ Macintosh:

1. Connect the recorder to a computer.

2. Double-click the drive icon (“NO NAME”) of the recorder on the desktop.

3. Double-click “VOICE” folder.

4. Double-click the folder (A-D) that contains the file that you wish to load to 
your computer.

5. Copy the file to the desired location.

Hint:
· Transferring audio files from the computer to the recorder

Drag and drop the audio file to the MUSIC (M) folder on the computer desktop in the 
Removable Disk icon (Windows) or recorder drive icon (Macintosh). Before transferring 
audio files to the VOICE (A-D) folders or LINE (L) folder, rename the files following the 
file naming rules (see page 59). The unit will not play files that do not comply with the 
file naming rule, unless they are in the MUSIC (M) folder.

Copying audio files to a CD-R
You can copy audio files (that were recorded on the POCKETRAK CX) to a CD-R disc by using 
Windows Media Player.

Please visit the Microsoft website for information on how to obtain Windows Media Player. 
http://www.microsoft.com/windows/windowsmedia/

Note:
· This section uses Windows XP and Widows Media Player 11 as examples.
· To copy audio files to a CD-R disc, you must have a CD writer, such as a CD-R/RW 

drive.

1. From the [Start] menu, select [All Programs], then click [Windows Media 
Player] to start Windows Media Player.
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2. Right-click [Burn] in the menu bar, then select [Audio CD] or [Data CD].

3. Insert a new CD-R/RW disc into the CD-R/RW drive.

4. Drag and drop the audio files you wish to copy to the Burn List pane in the 
Windows Media Player panel.

5. Click [Start Burn] to start copying the files to the CD-R/RW disc.

[Audio CD]
Audio files are converted to CD-DA format and copied to a CD-R/RW disc. 
You can play the disc on a CD-R compatible CD player in your home or car.

[Data CD]
Audio files (MP3 or PCM) are copied to a CD-R/RW disc without conversion. 
You can play the disc on a computer, but not on an audio CD player.

Right-click

Burn List

Click
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Using the POCKETRAK CX as a Music 
Player
If you install Windows Media Player or iTunes on your computer and transfer music files to the 
connected POCKETRAK CX, you can use the unit as a music player.

Please visit the Microsoft website for information on how to obtain Windows Media Player.
http://www.microsoft.com/windows/windowsmedia/

Note:
· This section uses Windows XP and Widows Media Player 11 as examples.
· Copying commercially-available music data is strictly prohibited except for your per-

sonal use.
· Yamaha makes no representations or warranties with regard to the content of files, and 

cannot be held responsible for the failure of transfers or downloads, or for damage or 
erasure of music files due to malfunction of the unit or your computer.

Ripping CDs (Creating compatible music files from music 
CDs)
You can import music files from music CDs into your computer and convert them to MP3 or 
WMA files so that they can be played on the POCKETRAK CX.

1. From the [Start] menu, select [All Programs], then click [Windows Media 
Player] to start Windows Media Player.

2. Right-click [Rip] in the menu bar, then select [Format] → [mp3].

Right-click
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3. Click [Rip] in the menu bar.

4. Insert a music CD into the computer’s CD-ROM drive.

Note:
· If your computer has access to the Internet, the system will automatically obtain and 

display music information related to the CD.

5. Check the box for each song that you wish to rip to your computer, then click 
[Start Rip].
The system starts ripping the CD.

Note:
· You can also set Windows Media Player so that inserting a music CD will automatically 

start ripping.

Click

Click

Check
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Transferring music files to the POCKETRAK CX (Sync func-
tion)
You can transfer audio files (ripped from a music CD to a computer) to the recorder for playback.

For information on how to rip a music CD, refer to the “Ripping CDs (Creating compatible music 
files from music CDs)” on page 62.

1. From the [Start] menu, select [All Programs], then click [Windows Media 
Player] to start Windows Media Player.

2. Click [Sync] in the menu bar.

3. Connect the recorder to the computer.

Note:
· If the system displays the “Device Setup” window, click [Finish].

4. Right-click [Sync] in the menu bar, then select [Pocketrak] → [Advanced 
Options…].

5. Check the box for “Create folder hierarchy on device” on the [Sync] tab, then 
click [OK].

Note:
· If the box has already been checked by default, the folder may not be created. Remove 

the check from the box, then check the box again, and then click [OK].

Check
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6. Drag and drop the desired music files from the Library pane in the left col-
umn of the window to the Sync List pane in the right column of the window.

7. Click [Start Sync].
The files will be transferred to the POCKETRAK CX.

Click
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Playing back tracks in a specific sequence

Creating a Playlist
You can create a Playlist to play back tracks in a desired sequence.
The recorder supports playlist files that are in M3U format with the extension “.m3u”. 
An M3U format file stores multimedia playlists that specify the location of media files 
(such as MP3 files).

1. From the [Start] menu, select [All Programs] → [Accessories], then click to 
open [Notepad].

2. Enter the file names included in the MUSIC (M) folder into the Playlist in the 
desired sequence.
Enter the file names into the Playlist in the following format: “Drive name:\Folder 
name\File name”. See the example below.

3. From the [File] menu, select [Save As…], then name the file 
“xxx(file name).m3u” to save the Playlist.

4. Transfer the saved Playlist file to the MUSIC (M) folder on the recorder 
(see page 58).
Be sure to transfer the Playlist file directly to the root level of the MUSIC (M) 
folder.

Note:
· You must place the Playlist file at the root level of the MUSIC (M) folder, NOT in any 

sub-folder inside the MUSIC folder.

5. Disconnect the recorder from the computer (see page 55).

Hint:
· For information on how to play tracks from the Playlist, refer to page 27.

Drive name Folder name File name
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Importing Audio Files into Cubase AI
The POCKETRAK CX ships with a DVD disc that contains the DAW software “Cubase AI.” You can 
use this software to edit and mix audio files. This section explains how to install Cubase AI and 
import audio files. For more information on using Cubase AI, refer to the PDF manual supplied 
with the Cubase AI software.

Step 1. Installing Cubase AI

Since the End-User Software License Agreement (EUSLA) displayed on your computer when 
you install the DAW software is superseded by the agreement in the included Owner’s Manual 
(printed version), you should disregard the EUSLA. Please read the Software License Agree-
ment in the included Owner’s Manual carefully, and install the software if you agree to it.

1. Start the computer and log on to the Administrator account.

2. Insert the included DVD-ROM into the computer's DVD-ROM drive.

3. Double-click the “CubaseAI4.msi” icon in the “Cubase AI 4 for Windows” 
folder (for Windows users), or double-click the “CubaseAI4.mpkg” in the 
“Cubase AI 4 for MacOS X” (for Macintosh users).
Follow the on-screen instructions to install the Cubase AI software.

Note:
· To continue to use Cubase AI and be eligible to receive support and other benefits, you 

will need to register the software and activate your software license by starting the soft-
ware while the computer is connected to the Internet. Click the “Register Now” button 
that is displayed when the software is started, then fill in all fields required for registra-
tion. If you do not register the product, you will be unable to use the application after a 
limited period of time expires. For a detailed registration procedure of Cubase AI, refer to 
the web site below.
<http://service.steinberg.de/goto.nsf/show/register_cubase_ai_4_gb>

Step 2. Connecting the recorder to your computer
Connect the recorder directly to your computer using the included USB cable.

IMPORTANT
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Step 3. Importing audio data into Cubase AI

1. Launch Cubase AI.

Windows:
Click [Start] → [All Program] → [Steinberg Cubase AI 4] → [Cubase AI 4] to 
launch the program. 

· If the “ASIO Multimedia” dialog window appears, click [Yes].

Macintosh:
Double-click the [Application] → [Cubase AI 4].

· If you specified a file destination when installing the Cubase AI software, launch the 
application from that location.

· Create a Cubase AI shortcut or alias on your desktop so that you can easily launch 
the program when required.

2. Select [New Project] from the [File] menu to create a new project file.
The new project dialog window will open. For this example select [CAI4 - 4 Stereo 
8 Mono Audio Track Recorder] and click [OK].

Note:
· Recorded Cubase AI data is stored as a “project file.”

Note:

Note:
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3. When the directory selection dialog window appears, select the folder to 
which the project and audio files for the project are to be stored, and click 
[OK].
An empty project window with 4 stereo and 8 monaural tracks will appear.

4. Click in the track list (the area in which the track names are displayed) to 
select a track into which to import audio data.
Various settings for the selected track are available in the Inspector on the left side 
of the display.

Project window

Mixer window

Transport panel

Inspector Track list
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5. Go to [File] menu → [Import] → [Audio File] → [My Computer] → “Remov-
able Disk”, then click [Open].

6. Select an audio file to import from the folder, then click [Open].

Note:
· If the “Import Options” dialog box appears, select the desired options, then click [OK].

7. To save the project file, select [Save] from the [File] menu, enter a file name, 
then save the file.
Save your project file frequently to avoid losing unsaved data in case a problem 
occurs.

Hint:
· For further instructions such as adding effects or mixing, refer to the PDF manual pro-

vided with the software.
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Recharging the eneloop

• Recharge the eneloop at an ambient temperature of between 5 and 35 degrees Cel-
sius (41 and 95 degrees Fahrenheit).

• Be sure to close the battery cover before you start recharging.

1. Make sure that the eneloop battery is inserted in the recorder.

• Do not attempt the recharge operation with an alkaline or other battery installed in 
the recorder. Otherwise, the battery liquid may leak or the recorder may malfunction.

2. From the main screen, press and hold down the [MENU/
ENTER] button for at least two seconds to access the 
[COMMON MENU] → [BATTERY SET], then make sure 
that “eneloop” is selected.

3. Connect the recorder to a computer (see page 54).

4. Make sure that the LCD screen 
on the recorder indicates that 
the unit is connected to the 
computer, then set the [HOLD/
CHARGE] switch to [HOLD w].
The LED lights up green, and 
recharging starts.
To cancel the recharge operation, 
revert the [HOLD/CHARGE] switch 
setting.
When recharging is complete, the 
LED turns off.

Note:
· Recharging a completely exhausted 

eneloop battery takes approximately 
220 minutes.

· You can recharge an eneloop battery during data transfer. However, the battery may be 
exhausted more quickly.

5. Disconnect the recorder from your computer.

Note:
· The battery may become warm during recharge, but this is normal.
· The battery life has come to an end if the battery is exhausted relatively quickly even after 

being fully recharged. Replace it with a new eneloop AA Ni-MH rechargeable battery.
· The battery may not be recharged under the following conditions:

- When the computer is in sleep mode
- While the computer is being restarted

· The crossed-out battery icon ( ) means that the recharging 
operation did not start for one of the following reasons:

- A non-eneloop battery has been loaded.
- There is no battery in the unit.
- The unit is overheated.

(Disconnect the unit from the computer, leave the unit with the 
power turned off for a while, then connect the unit to the com-
puter again.)

WARNING

DANGER
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Back of unit

Set to [HOLD w].

[HOLD/CHARGE] 
switch
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Error messages
The following table explains the error messages that you may see during operation of the POCK-
ETRAK CX.

Unit status or 
function Error message Description

Low battery

LOW BATTERY! 
REPLACE BATTERY

The alkaline battery is exhausted. Replace 
the battery with a new one.

LOW BATTERY! 
CHARGE BATTERY!

The eneloop is exhausted. Recharge the 
eneloop.

Recording

MEMORY FULL! The microSD card does not have sufficient 
free space for recording.

FILE FULL!
You attempted to record more files than the 
maximum number of files allowed for the 
selected folder.

Playback

NO DATA! You pressed the [PLAY/SPEED ] button but 
the selected folder contains no files.

CANNOT CHANGE 
PLAYBACK SPEED!

You attempted to change the playback 
speed while playing back a PCM recording. 
You cannot change the playback speed of 
PCM (WAV) files.

Editing (Index) INDEX FULL!

You attempted to insert more index marks 
than the maximum number (36) of index 
marks allowed per file. No more index marks 
will be recorded.

Editing 
(File division)

CANNOT DIVIDE! 
FOLDER FULL! 

You attempted to divide a file when the cor-
responding folder contains the maximum 
number of files allowed.

CANNOT DIVIDE! 
MEMORY FULL! 

The microSD card does not have sufficient 
free space to divide a file.

CANNOT DIVIDE! 
REC TIME 
TOO SHORT !

The recording is too short in duration to 
divide.

CANNOT DIVIDE! 
AT THIS POINT 

You cannot divide the file at the current 
point.
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Editing 
(Fade in/fade out)

CANNOT FADE IN! 
FILE TOO SHORT!

The file is too short in duration (four seconds 
or less) to apply the fade in effect.

CANNOT 
FADE OUT! 
FILE TOO SHORT! 

The file is too short in duration (four seconds 
or less) to apply the fade out effect.

CANNOT FADE IN!
READ-ONLY FILE!

You attempted to apply the fade in effect to 
a file other than a PCM (WAV) file. You can-
not apply the fade in effect to any files other 
than PCM (WAV) files.

CANNOT 
FADE OUT! 
READ-ONLY FILE!

You attempted to apply the fade out effect 
to a file other than a PCM (WAV) file. You 
cannot apply the fade out effect to any files 
other than PCM (WAV) files.

MEMORY FULL! 
The microSD card does not have sufficient 
free space for applying the fade in or out 
effect.

Editing (General) CANNOT EDIT! 
READ-ONLY MODE!

You pressed the [EDIT/PHRASE] button to 
edit a file in the MUSIC folder.

List screen NO FILE The selected folder does not contain any files 
that can be played on the unit.

Recycle Bin

CANNOT EDIT! 
READ-ONLY MODE!

You pressed the [EDIT/PHRASE] button to 
edit a file in the Recycle Bin folder.

FOLDER FULL!

You cannot move the file from the Recycle 
Bin to its original folder because the folder 
contains the maximum number of files 
allowed.

RECYCLE BIN FULL!

You attempted to delete a file while the 
Recycle Bin function was turned on and the 
Recycle Bin folder contained the maximum 
number of files allowed (500 files).

microSD card

NO MEDIA!
You attempted to record or play back a file 
with no microSD card inserted inserted. 
Insert a microSD card.

SD CARD 
ACCESS ERROR!
INSERT AGAIN!

The recorder did not recognize the inserted 
microSD card, or the card is broken. Try 
inserting the card again.

SD CARD 
WRITE SPEED 
TOO SLOW!

PCM recording was incomplete or the data 
was not written correctly.

Unit status or 
function Error message Description
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Troubleshooting

The unit does not operate.

Possible cause Battery is not inserted properly or is exhausted.

Corrective action
Reinsert the battery correctly.
Recharge the eneloop or replace with a new alkaline battery (see page 71).

Buttons do not work.

Possible cause The Hold function is set.

Corrective action
Set the [HOLD/CHARGE] switch (located on the rear panel of the unit) to 
its original position to cancel the Hold function.

Possible cause The USB terminal is still connected to the computer.

Corrective action Disconnect the unit from the computer (see page 55).

The eneloop cannot be recharged from the connected computer.

Possible cause The BATTERY SET is set to “ALKALINE.”

Corrective action Set the BATTERY SET to “eneloop” (see page 51).

Possible cause The [HOLD/CHARGE] switch is not set correctly.

Corrective action Set the [HOLD/CHARGE] switch to [HOLD w].

Icon " “ appeared when you attempted to recharge the battery.

Possible cause
• You attempted to recharge a battery other than the eneloop.
• You attempted to recharge the battery, but no battery was inserted.
• The eneloop is not inserted correctly.

Corrective action Insert the eneloop battery into the unit.

Possible cause The unit is overheated.

Corrective action
Disconnect the unit from the PC, let the unit cool down for a while, then 
try to recharge again.

The unit does not recognize the inserted microSD card.

Possible cause The microSD card is not inserted correctly.

Corrective action Turn off the power to the unit, then insert the microSD card correctly.

Possible cause
The microSD card was formatted on a computer or device other than the 
recorder.

Corrective action Use the POCKETRAK CX to format the microSD card (see page 46).
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No sound.

Possible cause The volume is turned down too low.

Corrective action Use the [VOL +/-] button to adjust the volume level.

Files in the VOICE (A-D) folders cannot be played.

Possible cause The file name is wrong.

Corrective action
If you change the file name on a computer, then move the file back to the 
VOICE (A-D) folder, you cannot play the file on the unit. Transfer the file to 
the MUSIC (M) folder to play it.

Possible cause
The audio file is not in the type of WAV format that is supported by the 
unit.

Corrective action The unit will not play back a WAV file that was not recorded on the unit.

Files in the MUSIC (M) folder cannot be played (correctly or at all).

Possible cause The file is not in a playable format.

Corrective action Use MP3 or WMA files.

Possible cause
The audio file is not in the type of PCM (WAV) format that is supported by 
the unit.

Corrective action The unit will not play back a WAV file that was not recorded on the unit.

Possible cause The file was transferred to an incorrect destination.

Corrective action
The unit will not play files that were transferred from a computer to a 
folder other than the MUSIC (M) folder. Be sure to transfer the file to the 
MUSIC (M) folder on the Removable Disk.

Possible cause The file is not compatible with the unit.

Corrective action Create a file using different MP3/WMA encoder software.

Possible cause The files listed in the Playlist are missing from the MUSIC (M) folder.

Corrective action
Delete the file names from the Playlist. Alternatively, transfer the missing 
files to the MUSIC (M) folder.

Possible cause A different transfer method was used.

Corrective action
Files protected by copyright cannot be played if they are transferred via 
Explorer. Use Windows Media Player to transfer the files (see page 64).
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A file cannot be divided.

Possible cause The microSD card may have insufficient free space.

Corrective action Erase unnecessary files (see page 45).

Possible cause The file is too short to divide.

Corrective action
The minimum file length required for the file division operation varies with 
the recording mode (see page 38).

A file cannot be erased.

Possible cause The attribute of the file is set to “read only.”

Corrective action
Connect the unit to a computer and change the file attribute or erase the 
file using the computer. Alternatively, format the microSD card (see 
page 46).

The Removable Disk icon does not appear when you connect the unit to the computer.

Possible cause The unit is not connected to the computer correctly.

Corrective action
Make sure that the USB cable is securely and correctly connected to the 
unit and to the computer (see page 54).

Possible cause Power supplied from the computer to the unit is insufficient.

Corrective action

If the recorder is connected via a bus-powered USB hub, remove the hub, 
then use the included USB cable to connect the recorder directly to the 
computer’s USB terminal. Alternatively, use a self-powered USB hub (with 
the power adapter). If the computer features multiple USB terminals, use a 
different USB terminal to connect the recorder (see page 54).

Possible cause A network drive has been assigned.

Corrective action

If a network drive has been assigned, the drive letter (an alphabet letter 
used as the drive name) is already taken. In this case, the Removable Disk 
icon may not be created. Change the network drive assignment, then 
reconnect the unit.
Consult your network administrator regarding how to reassign the net-
work drive.

Possible cause The connected computer does not recognize the recorder.

Corrective action
If the computer does not recognize the unit, try connecting it again. If 
you connect the unit to any computer other than those supported by the 
unit, Yamaha will not guarantee the operation of the unit (see page 54).

The file transfer speed (from the computer to the unit) is slow.

Possible cause The unit is connected to a USB1.1 terminal on the computer.

Corrective action Connect the unit to a USB2.0 High Speed terminal.
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When the unit is connected to the computer, the unit does not display the “Connected” icon.

Possible cause The unit is not connected to the computer correctly.

Corrective action
In some cases, the unit may not display the “Connected” icon or may not 
be recognized when it is connected to a computer. Disconnect the unit 
from the computer, then reconnect it.

The recorded audio sounds noisy.

Possible cause Wind noise has been recorded.

Corrective action

The built-in stereo microphone is highly sensitive. Therefore, a slight 
breeze or breath — even a weak air conditioning breeze that hits the 
microphones directly — will be recorded as noise. To reduce the level of 
wind and other environmental noise: 
• Use the recorder with the wind screen (protection against wind and sib-

ilance) attached to the built-in stereo microphones.
• Turn on the High Pass Filter via menu item [HPF] (see page 21).
• Set the [MIC SENS] (microphone sensitivity) switch to [LOW].

The recorded sound is distorted.

Possible cause The microphone sensitivity level may not be appropriately set.

Corrective action

• Set the [MIC SENS] (microphone sensitivity) switch to [LOW]. If you still 
hear distortion, set the High Pass Filter to ON and attach the wind-
screen to the recorder (see page 21).

• If the ALC function is turned off, set the recording peak limiter to ON 
(see page 21).

The recorded sound skips.

Possible cause
• The microSD card was formatted not on the recorder, but on a com-

puter or other device.
• The microSD card may be fragmented significantly.

Corrective action Use the recorder to format the microSD card (see page 46).

The date and time are displayed incorrectly.

Corrective action Set the correct date and time (see page 9).

Deleting files does not increase the amount of free space.

Possible cause The Recycle Bin function is turned on.

Corrective action Empty the Recycle Bin (see page 44).
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FAQ

Q: May I use a manganese battery ?
A: Do not use a manganese battery or NiCad battery. You may use an oxyride battery, but 

Yamaha will not guarantee the operation. (The battery life would be about the same as that of 
alkaline batteries.)

Q: Why do I hear a rustling noise in the recordings?
A: A rustling noise may be recorded if you move the unit during recording, or even if you move 

your fingers while holding the unit when recording. If possible, try not to move the unit 
during recording.

Q: How can I transfer the recordings onto tapes or MDs?
A: Use a standard audio cable (with 3.5mm mini plugs) to connect the unit to your tape 

recorder or MD recorder, then dub the recordings to a tape or MD.

Compatible audio cable

* Use a stereo audio cable.
* Before dubbing the recordings, adjust the dubbing level on the unit.
* You can also dub the recordings from your tape player or MD player to the unit (see 

page 14).

Q: Are there any tips to making a good recording?
A: Try a test recording to set the optimum recording mode and sensitivity (see page 10), since 

the recording condition varies with the location and circumstances.

Q: Does the available recording time specified in the manual apply to each file?
A: No, it refers to the available recording time on a microSD card. The available recording time 

in each recording mode refers to the total time available for one continuous recording 
without changing the recording mode, and assumes that no recorded files exist on the 
microSD card. Therefore, if you record one file until the microSD card is full, you cannot 
record further even if you change the file or folder.

Socket on the external recorder Audio cable

Microphone input 3.5-mm mini plug, with resistance

Line input 3.5-mm mini plug, without resistance

Stereo 
headphone 

socket

Microphone/
Line input 

socket

External recorder

Standard audio cable
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Q: I cannot play a recorded file that was stored on the computer and transferred 
back to the unit.

A: You may have changed the file name on the computer. If you change the file name, the file 
will not play, even if it is transferred back into the VOICE or LINE folder. However, you will be 
able to play the file if you transfer it into the MUSIC folder.
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Specifications

Supported OS 
Windows Vista, XP Professional/Home Edition

Mac OS X 10.4, 10.5

Supported media microSD/SDHC card

Recording mode and available 
recording time (with the included 
2GB microSD card)

PCM 48 kHz: Approx. 2hr.50min.

PCM 44.1 kHz: Approx. 3hr.5min.

MP3 320 kbps: Approx. 13hr.35min.

MP3 192 kbps: Approx. 22hr.45min.

MP3 128 kbps: Approx. 34hr.5min.

MP3 64 kbps: Approx. 68hr.15min.

MP3 32 kbps: Approx. 136hr.30min.

Recording format MP3, PCM (WAV)

Playback format
MP3 (MPEG1 LAYER3, MPEG2 LAYER3), WMA

PCM (Only files recorded on this unit are supported.)

Frequency response (recording with 
an external microphone)

40–23,000Hz (PCM 48kHz, 16bit)

40–21,000Hz (PCM 44.1kHz, 16bit)

40–20,000Hz (MP3 320kbps)

40–20,000Hz (MP3 192kbps)

40–15,000Hz (MP3 128kbps)

40–7,500Hz (MP3 64kbps)

40–6,500Hz (MP3 32kbps)

Frequency response (recording with 
the built-in microphone)

60–20,000Hz (PCM recording)
* The high end frequency response varies with the recording mode 

that was selected for recording with an external microphone.
The low end response is 60Hz in all MP3 recording modes.

Frequency response (playback) 20–23,000Hz

Sampling frequency 16kHz–48kHz

Bit rate (playback)

16–320kbps (MP3)

32–192kbps (WMA)
* Some files may not be played back correctly.

Connectors
USB mini, Stereo headphones 3.5-mm mini, Stereo micro-
phone (line input) 3.5-mm mini, microSD card slot

Operating temperature +5˚C – +35˚C (+41˚F – +95˚F)

Output (headphones) 10mW + 10mW (at 16Ω load)

Power supply Eneloop AA Ni-MH rechargeable battery (1) 
Or, “AA/LR6” alkaline battery (1) 
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• Battery life varies depending on the type and manufacturer of the battery/
microSD-card, storage conditions, usage, ambient temperature, etc. The bat-
tery life values listed above are estimates and are not guaranteed. Yamaha will 
not guarantee operation if you use any battery other than an alkaline battery or 
a rechargeable battery specified by Yamaha (eneloop).

• Specifications and descriptions in this owner’s manual are for information pur-
poses only. Yamaha Corp. reserves the right to change or modify products or 
specifications at any time without prior notice. Since specifications, equipment 
or options may not be the same in every locale, please check with your Yamaha 
dealer.

Battery life for recording (with the 
included 2GB microSD card) 

Alkaline battery: MP3 Approx. 54 hours, PCM Approx. 22 
hours

Eneloop: MP3 Approx. 44 hours, PCM Approx. 
21.5 hours (Recording condition: Record-
ing LED off, backlight off, no recording 
monitoring, ALC on)

Battery life for playback through 
headphones (with the included 2GB 
microSD card) 

Alkaline battery: MP3 Approx. 58.5 hours, PCM Approx. 
25 hours

Eneloop: MP3 Approx. 48 hours, PCM Approx. 23 
hours (Playback condition: Playback LED 
off, backlight off, no recording monitor-
ing, FLAT sound EQ)

Battery life for playback through the 
speaker (with the included 2GB 
microSD card) 

Alkaline battery: MP3 Approx. 38 hours, PCM Approx. 
19.5 hours

Eneloop: MP3 Approx. 32 hours, PCM Approx. 
19.5 hours (Playback condition: Playback 
LED off, backlight off, no recording moni-
toring, FLAT sound EQ)

Dimensions Approx. 46.5(W) x 129.5(H) x 17.5(D) mm

Weight Approx. 91g (including “eneloop”)

Included accessories

Eneloop AA Ni-MH rechargeable battery (1) 
2GB microSD memory card (1) 
Earphones (1) 
Carrying bag (1)
Microphone stand adapter (1) 
Windscreen (1) 
DVD-ROM (1)
USB cable (1)
Owner’s Manual (1)
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Index

Symbols
 button................................... 4, 12
 button................................... 4, 12 

A

 

A-B Repeat playback ........................... 31
Alarm.............................................. 48
ALC (Auto Level Control) ..................... 10
ALC ON/OFF switch ............................ 6
Audio cable ................................ 15, 78
Audio files ........................................ 60
Auto Divide ...................................... 23
Auto Power Off ................................. 52
Available recording time ...................... 16 

B

 

Backlight ......................................... 52
Battery cover ..................................... 6
Battery setting................................... 51
Beep sound ...................................... 52
Bit rate ........................................ 7, 16
Built-in stereo microphone .................... 4 

C

 

CD ........................................... 60, 62
CD player ........................................ 14
Clear Voice....................................... 33
Computer ........................................ 54
Contrast .......................................... 53
Cubase AI ........................................ 67 

D

 

Date ................................................ 9
DEL button........................................ 6
Deleting

Deleting a selected file..................... 45
Deleting all data ............................ 46
Deleting all files from a folder............ 46

Dividing files..................................... 37 

E

 

EDIT/PHRASE button ............................ 5
Editing Files ..................................... 37
Eneloop .......................................... 71
EQ (equalizer).............................. 18, 34
Error messages.................................. 72
External audio device ......................... 14
External microphone ..........................  10 

F

 

Fade in ........................................... 39
Fade out .........................................  39
FAQ ............................................... 78
Fast forwarding ................................. 28
Fast reversing ................................... 28
File ................................................ 57
File names .................................. 38, 59
Folder............................................. 57
Folder structure................................. 59
FOLDER/A-B REPEAT button .............. 5, 11
Formatting a microSD card .................. 46
Frequency ............................. 16, 18, 34 

H

 

Headphones..................................... 28
Headphones socket .............................. 6
High Pass Filter (HPF)..........................  21
HOLD/CHARGE switch.......................... 6 

I

 

Index marks ..................................... 40
Indicators displayed during playback ...... 27
Indicators displayed during recording.....  13
Initializing the menu settings ................ 53 

L

 

LCD screen .................................... 4, 7
LED............................................. 5, 25
Level meter ................................. 11, 13
Linear PCM ........................................ 7
List screen ......................................... 8
LIST/INDEX button .......................... 5, 8
Locating the file to play back ................ 28
Locating the index............................. 28
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M

 

Main screen....................................... 8
Manual............................................. 3
MD ................................................ 78
Menu.............................................. 50
Menu item list ................................... 50
Menu screen...................................... 8
MENU/ENTER button........................ 4, 8
MIC LEVEL (recording level).................. 12
MIC SENS HIGH/LOW switch ................. 6
MIC/LINE  socket ............................ 5
Microphone ..................................... 10
Microphone sensitivity ........................ 10
Microphone stand (adapter) ............. 6, 11
microSD card ................................ 6, 46
MP3 ...................................... 7, 10, 16
Music.............................................. 62 

P

 

PCM (WAV) ............................. 7, 10, 16
PLAY/SPEED  button......................... 5
Playback .......................................... 26

Playing back files............................ 26
Playing back tracks from the Playlist .... 27
Repeat playback............................. 32
Using the A-B Repeat playback 

function..................................... 31
Using the Phrase playback function..... 31
Using the Skip playback function........ 30

Playback speed.................................. 29
Playlist............................................. 66
POWER button ................................... 5 

R

 

REC/PAUSE  button.......................... 4
Recharging....................................... 71
Recording

Recording from an external audio 
device (such as a CD player) ........... 14

Recording musical performance ......... 11
Simple recording............................ 13

Recording EQ (equalizer) ..................... 18
Recording level.................................. 12
Recording mode .......................... 10, 16
Recording peak limiter .................. 12, 21
Recycle Bin....................................... 42
Repeat playback .......................... 31, 32 

S

 

Screens ............................................. 8
Self timer.........................................  24
Skip playback ................................... 30
Sound EQ (equalizer)..........................  34
Sound quality ................................... 16
Speaker............................................. 6
Specifications ................................... 80
STANDBY mode ................................ 11
Stereo mini plug ...............................  15
Stereo wide recording ........................ 21
STOP/ESC  button............................ 4
Sync............................................... 64 

T

 

Threaded socket for attaching a tripod...... 6
Time ................................................ 9
Timer recording ................................ 47
Tripod ............................................ 11
Troubleshooting........................... 56, 74 

U

 

USB terminal ................................. 6, 55
USER ......................................... 20, 36 

V

 

VAS (Voice Activated System) ............... 22
Version ........................................... 53
Voice sensing level (VAS value) ............. 22
VOL + / - button ................................. 4
Volume ............................................. 4 

W

 

Wind screen ..................................... 10
Windows Media Player........................ 60 
CKETRAK CX   Reference Manual 83
U.R.G., Pro Audio & Digital Musical Instrument Division, Yamaha Corporation

© 2008 Yamaha Corporation
904IP-C0


	Table of Contents
	Starting Up
	Part names and functions
	Front, side and back panels
	LCD screen

	About the screens
	Navigating the list screen

	Setting the current date and time

	Recording
	Before recording
	Attaching the wind screen (protection against wind and sibilance)
	Selecting a Recording mode
	Turning the ALC (Auto Level Control) function on or off
	Setting the microphone sensitivity
	Using an external microphone
	Attaching the recorder to a tripod or a microphone stand

	Recording a musical performance
	Adjusting the recording level

	Simple recording (musical practice, meeting, etc.)
	Recording from an external audio device (such as a CD player)

	Recording Settings
	Changing the Recording mode (Selecting a sound quality)
	Changing Recording mode

	Turning the ALC (Auto Level Control) on and off
	Setting the recording EQ (equalizer)
	About recording EQ options
	Selecting a recording EQ option
	Customizing the recording EQ

	Setting the recording peak limiter
	Setting the High Pass Filter (HPF)
	Setting Stereo Wide recording
	VAS (Voice Activated System) recording
	Setting the voice sensing level (VAS value)

	Setting the Auto Divide function (AUTO DIVIDE)
	Recording with the self timer
	Changing the LED setting

	Playback
	Playing back files
	Playing back tracks from the Playlist
	Indicators displayed during playback

	Fast forwarding and fast reversing
	Using headphones

	Playback Settings
	Changing the playback speed
	Playing back specific sections of a track
	Using the Skip playback function
	Using the A-B Repeat playback function
	Using the Phrase playback function

	Playing back the same track repeatedly
	Playing back with less noise (Clear Voice)
	Setting the sound EQ (equalizer) (applicable only to the M and L folders)
	About the sound EQ options
	Selecting a sound EQ option
	Customizing the sound EQ option


	Editing Files
	Dividing files
	Using the fade in and fade out effects
	Applying the fade in effect
	Applying the fade out effect

	Inserting and deleting index marks
	Inserting index marks
	Deleting index marks


	Deleting
	Managing the Recycle Bin
	Activating the Recycle Bin function
	Displaying the Recycle Bin folder
	Playing back a file in the Recycle Bin folder
	Restoring a file from the Recycle Bin folder
	Emptying the Recycle Bin folder

	Deleting a selected file
	Deleting all files from a folder
	Formatting a microSD card (Deleting all data)

	Using the Timer Functions
	Programming Timer recording
	Programming the alarm

	About the Menu Settings
	Menu and menu item list
	Setting the menu options
	Selecting the battery type
	Turning the beep sound on or off
	Activating the Auto Power Off function
	Setting the Backlight function
	Adjusting the LCD contrast
	Initializing the menu settings
	Checking the firmware version

	Using the POCKETRAK CX with a Computer
	Computer system requirements
	Connecting the recorder to your computer
	Disconnecting the recorder from your computer
	Troubleshooting (Windows Vista/XP)
	About files and folders
	About the file naming rules

	Transferring audio files from the recorder to a computer
	Copying audio files to a CD-R

	Using the POCKETRAK CX as a Music Player
	Ripping CDs (Creating compatible music files from music CDs)
	Transferring music files to the POCKETRAK CX (Sync function)
	Playing back tracks in a specific sequence
	Creating a Playlist


	Importing Audio Files into Cubase AI
	Recharging the eneloop
	Appendix
	Error messages
	Troubleshooting
	FAQ
	Specifications
	Index


